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1 Introduction

Dear Customer,

Welcome to Voltcraft®. Thank you for purchasing this product and we are sure you have made
a very good decision.

Voltcraft® - in the field of measuring, charging and network technology, this name represents
high quality products which perform superbly and which are created by experts employing
continuous innovation and improvement. From ambitious hobby electronics enthusiast to
professional user, products from Voltcraft® brand family provide the optimum solution even
for the most demanding tasks. Voltcraft® products also offer an almost unbeatable price-
performance ratio. This is why we are absolutely certain: With our Voltcraft® product line, we
have created the foundation for a long, prosperous and successful customer partnership.

We wish you have a great deal of enjoyment from your new Voltcraft® product!



Voltsoft User Manual Version 2.5

Table of Contents

1 I ) e Y 16 o o] o 2
2 UsiNg this ManuUal ... e ettt raaeeann 4
3 B = = X o o 5
Gt R S Y £51 1= g (=0 [ 8 T (=1 g 1= ) 5
3.2 1Sy =T Y ] 1 =0 ) 1 oS 6
3.3 Migrate eXiStiNG ata .. ...t 9
G R = LT 1153 (=T gV ] 1 6T ) i 10
PR S = 1 g Yo F= Y o BV =Y = [0 o 12
4.1 Launch the VoItsoft WIindows CHeNt .......c.ooiiiiii i aaeee e 12
N € 1= o =T = IS o [ o e 13
A3 AAd NEW DBVICE ..t ettt 15
4.4  ReMOVE EXISTING DBVICE ... ittt et ettt ettt e e eeaneeeaanan 16
4.5 Device Control Panel ... s 17
5 Professional VerSiON ... 18
5.1 (0 ST =] 1Y =T F= T 1= o g T o 18
5.2 Email ManagemEnt ... ...t aaas 19
5.3  EMail TemMPIate ... 20
LS o 1 1= U1 N L= o P 21
LS S T O U 1= (e 1 €1 =T o o P 22
LI T V1YL= o T 1 g (=Y =T 24
LS T S oo T X (=T I D TSNV T o T 34
S 700 I e 0 35
S T2 I | 0t 22 R I 41
TG N I 1 e 1 47
S T I 1 02 5 I 55
TS T I T 00 G 1 0 61
TG I T 0 0 5 I 2 69
S T A I T I i I | 75
LTS 15 T 1 e i 81 G 82
TS R I Tt G 1 S A 88
S 0 0 T I T 2 0 1 I 1 94
G 0 5t 1 e 5t 5 5 100
S 0 2 0 0 I i 106
S 0 5 T 15 1 L i 112
G 0 15 T 0t L L 118
6.15 DL200T / DL210TH /7 DL220THP .. ettt ettt et e et et e et e e e e e aaeaaas 124
.16 PL-125-T2 / PL-d 25T ittt ettt et ettt e et 132
6.17 IR 1200-50D / IR L1201-50D .. .uiiiiiiiii et e e e et e e et aas 138
G T I L 146
ST S Y ¢ 1T IV 01 1 0 153
ST O I 0t 51 50 I AV 0 5150 161
G T2 Y < 1T 170
G 2 2 T 0 O 180
A U | o T U o T | = T = 187
S J AN 01 o 11 i (o 1 188
8.1  Real-Time deViCe lSt .. ... e aaeens 188
8.2 INternet EXPIOrer L0 ...ttt 188



Voltsoft User Manual Version 2.5

2 Using this Manual

The Voltsoft System (Voltsoft) is integrated control software for controlling different Voltcraft®
electronic products. By using Voltsoft, you can manage your Voltcraft® products using only a
single piece of software.

This manual will explain the usage and workflow of different components of Voltsoft, and also
discuss how Voltsoft can control different hardware models.

There are many terms and abbreviations in this manual that may be unfamiliar to you if you
are new to web hosting. You can find information on these terms and abbreviations in the
glossary of this manual or by searching them using an Internet search engine such as Google.
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3 Installation

3.1 System Requirements

To install Voltsoft, your computer should contain:
- Pentium 233-megahertz (MHz) processor or faster
- At least 1GB of RAM
- At least 2GB of available space on the hard disk
- USB 2.0/ 3.0 Port(s)

Voltsoft only supports the following operating systems:
- Microsoft Windows XP Service Pack 2 or above
- Microsoft Windows Vista Service Pack 2 or above
- Microsoft Windows 7
- Microsoft Windows 8
- Microsoft Windows 10

If your Windows does not contain the corresponding service pack version, please perform a

Windows update first.

.NET framework library version:
- .NET framework 2.0 SP2

If your Windows does not contain the corresponding .NET framework, Voltsoft setup will help
you to download it from the Internet. However, it is recommended upgrading first before

installation.

Some device may not work if connecting via USB Hubs, included:

- DL101T / DL121TH / DL161S / DL180THP / DL111K
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3.2 Install Voltsoft

1. Insert the installation CD-ROM in your drive.
2. The menu will be opened automatically (if installation doesn’t start, double-click
autorun.exe in your CD-ROM directory). Follow the on-screen instructions.

Step 1: Select the installation language

Select Setup Language g|

Select the language ta use during the installation:

15X
Welcome to the Voltcraft -
Voltsoft System Setup Wizard

Thig will inztal Yolicraft - WVolkzoft Spstem Yerzion 1.0 on wour
computer.

It iz recommended that you cloze all other applications before
continuing.

Click Mext to continue, or Cancel o exit Setup.

[ Meut> |[ Cancel
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Step 3: Select Destination Location

\/ Setup - Yoltcraft - Yoltsoft System

Select Destination Location
Where should Voltcraft - Valtzoft System be installed?

LJ Setup will install Volteraft - Voltsoft System into the following folder.

To continue, click Nest. If you would like to select a different folder, click Browse.

IC:\Program Files\Voltsof ‘ | Browse...

Al least 67.5 MB of free disk space is required.

[ < Back ]uexb ] [ Cancel ]

Step 4: Tick the checkbox to create desktop icon for Voltsoft

\/ Setup - Voltcraft - Voltsoft System

Select Additional Tasks
‘Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing Yoltcraft -
Valtsoft System, then click Next.

Additional icons:

< Back ]I_ﬂexl) ][ Cancel }
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Step 5: Click “Install”. Installation will begin.

\/ Setup - Yoltcraft - Voltsoft System

Ready to Install

Click Install to continue with the installation, or click Back if you want to review or
change any settings.

Destination location:
C:\Program Files\Voltsoft

Additional tasks:
Additional icons:
Create a desktop icon

Setup is now ready to beain installing Voltcraft - Yoltsoft System on your computer.

P

b

[ < Back ]l Install ;|[

Cancel ]

"\/ Setup - ¥oltcraft - Yolisoft System

Installing

Pleaze wait while Setup installz Waoltcraft - Yoltzoft Syztem on pour computer.

Estracting files...
C:%Proagram FilestWoltzoft W eb Server\Device'webhbinhSystem. Data. SO Lite. dll
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Step 6: Click “Finish” to complete the installation

"\/ Setup - Yoltcraft - Yoltsoft System E|§|E|

Completing the Voltcraft - Voltsoft
System Setup Wizard

Setup has finished installing Volbcraft - Volksoft Syatem on your
computer. The application may be launched by zelecting the
installed icons.

Click Finizh to exit Setup.

3.3 Migrate existing data

If you have an old version of Voltsoft installed, following dialog will be prompt. Click “Yes” if
you want to keep existing data or “No” if you want to have an empty database.

Voltsoft

Old database found, click "Yes' if you want to migrate the data or ‘Mo’ if you want
a blank database.
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3.4 Register Voltsoft

Voltsoft has two different versions:

Standard and Professional.

contains more features than the standard edition.

Standard vs. Professional

The professional version

Standard Professional
User Management
Email Management
General Settings \A

Language Preference

Email Template

Device Management (Add / Remove)

Custom Graph

Email Alert

Web Interface

SRR

Voltsoft will be installed by default as the standard version. In order to enable the professional
features, you have to purchase a software package (VoltSoft Data Logger, BN: 101333) and

enter a valid license key (which is attached on CD) to register.

To register:

1. Launch the Voltsoft Windows client

\/ MOLTCRAFT - Voltsoft

File  Dewice Management  Help

=

10

-
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2. Click Help -> Online Activation

|

HONDURAS v

g
®

3. Enter a valid license key and the registration information.

4. Enter the proxy server settings if your computer accesses the Internet through a proxy
server.

Please read and accept our privacy policy and license agreement.

Click the “Activate” button to perform online activation.

If activation is successful the following message will be displayed:

Now

Voltsoft |g|

Activation Success

If there is any problem during online activation, user can activate via offline activation.

1. Click the Offline Activation button and select the location for saving the activation file
(Voltsoft.config)

Send the Voltsoft.config to our customer service, email kundenservice@conrad.de
Our customer service will return the license file (dms.config) to you.

Copy it to the install directory (e.g. C:\Program Files (x86)\Voltsoft)

Start Voltsoft again.

arwn

11
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4 Standard Version

4.1 Launch the Voltsoft Windows Client

To start the application, please go to Start Menu -> All Programs -> Voltcraft -> Voltsoft Client
Main screen of the Voltsoft client is as follows:

"\/ | VOLTCRAFT - Voltsoft 9(=(c3

File  Device Management  Help

SL451 - 400 DL101T - Logger 1 - X

Device  Graph

.................. Data y Graph \ 3

......... DL101T - Logger 1

0 : .

25+

20 +

Temperature(°C)
o
}

i ‘ : : : : : : :
0:50:32 085047 085102 085117
04-05.2011 04-05-2011 04.-05-2011 04.-05.2011

Time: 04-05-2011 06:51:05 Temp.:28.8(°C)

1 Main Menu Area Users can access different functions through the main
menu.

2 Device List Area Contains the list of devices which are already registered in
the system.
Green icon — Indicates that the device is currently
connected to the computer
Red icon - Indicates that the device is currently not
available.

Clicking on the icon can open that device in the device
control panel area.
3 Device Control Panel The opened device will be displayed in this area.

12
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4.2 General Settings

To launch this module, please click File->Settings.

=

|/ General Settings

IInit Preference

Temperature | Celsius

Air Fressure hPa

Drata Storage
2

Remaove recards after |60 % | Dayis)

Lownload Laka

[] Owenwrite data with duplicate download time 3

Ernal sethngs

Email Sender | no-reply@cei.com 4

SHTP Semer smip.hkhn.net Faort |25

Login 1D Passwaord

[ | Enable S5L

Web Serer Setting 5

Maxirmum Mumber of Login |2 &

Welcome fmessage  |YVelcome message

Fort Mumhber a0

URL it 92 168.1.1 30¢

6 [ Restart Woltzoft Serer ] [ Save ] [ Cloze l

Unit Preference Select the measurement unit used in Voltsoft.
Data Storage In order to prevent data overload, the system will delete

old data automatically. User can specify the number of days
to keep the device readings.

Download Data If this option was checked and the system is downloading
new data with measurement time, which already existed in
the database, then existing data will be overwritten.

Email Settings This area configures the outgoing email settings.

Email Sender — This will be the email sender of the alert
email.

SMTP Server and Port — The outgoing SMTP server name
and port number. (for Gmail, port number is 465)

Login ID and Password — The SMTP server login and
password (if required).

Enable SSL — Check this checkbox if your SMTP server
requires SSL encryption (i.e. Gmail)

13
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This setting is available in the professional version only.
5 Web Server Setting Configure the web server port number for the web-based
version of Voltsoft.

The local IP address will also be displayed, however, if you
have more then one network card, then only the first IP
address detected will be shown here.

The maximum number of logins controls the maximum
number of concurrent logins.

6 Restart Voltsoft Restart the Voltsoft Server.
Server
Save Save and quit this module.
Close Quit this module without saving.

14
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4.3 Add New Device

This module should automatically pop up when the user plugs a new device into the computer.

Device Management System

Mew device detected, do wou want to add it inko the system now?

| s | [ Mo

However, to launch this module manually, click Device Management->Add New Device.

"/ Add New Device C0X]
Device Series |Data Logger v| 1
Model Mumber | DL121TH v/
Alias |L|:|gger 121 |

2 3 4
[ Auto-Detect ]I[ Add l|| Cloze ]l

1 Select Device To add a new device:
1. Select the device series (only Data Logger available in
the current version).
2. Select model number.
3. Enter a unique alias.

2 Auto-detect Click this button to let the system detect if there is any
device connected but not yet registered.

3 Add Click the Add button to confirm the addition.

4 Close Click the Close button to close this module.

15
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4.4 Remove Existing Device

This module allows the user to remove devices which are no longer in use. To launch this
module, click Device Management->Remove Existing Device.

\/ Remove Existing Device [Z”E|E|

DATALOGGER - DLT141TH - 140
DATALOGGER - DL141TH - 140-2
DATALOGGER - 50451 - 400
CATALOGGER - DL1MT - Logger 1
DMM -C330 - 930

DM - C350 - 350

Remove All ][ Remove ][ Cloze

To remove a device, click the device in the list and click the “Remove” button.
Click “Remove All” button to remove all devices at the same time.

16
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45 Device Control Panel

The opened device will be displayed in the device control panel area in tab format. Each tab
will contain information for one single device.

51451 -400 ) DL1OLT - Logger 1 ] - X
Device Graeh Il

Data Lo E Graph 2

DL101T - Logger 1

[ Temperature |
an : . T T - - T

a0 4

Temperature(°C)
T

10 +
s 1

o4 - - : - : - - :
0B:50:32 0B:50:47 06:51:02 0B:51:17
04-05-2011 04-05-2011 04-05-2011 04-05-2011

Time: 04-05-2011 06:51:05 Temp.:28.8(°C)

Each device tab contains:

1 Device Menu Area Each device will contain its own menu, which will be
explained in an upcoming section.

2 Data Tab Display the selected data in list form.

3 Graph Tab Display the selected data in a graphical format.

The function of the modules may be different for different devices, therefore, they will be
discussed in individual device section.

17
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5 Professional Version

All features of the standard version and some advanced features are included in the
professional version. The following features will be available after online activation of the
professional version.

5.1 User Management
To launch the user management module, click on File->User Management on the main menu.

The user management of this module is only for the web-based version.

\/ User, Management

SIS

The following user[z] will be available for web only.

Login Marme Full Harne

adrmir Adrminiztrator

Login Mame |

EEEETTS

Paszword

EEEETTS

Confirm Pazsword

Full Mame |.-5'-.|:|ministrat|:|r

E=piny Crate |

Active (*) Yes () Mo

[ T |

ey

|zer M anagement

Select the device if you want to hide it from that user.

R
[]12
[]14
] 181

] 180
[] 4000

1 User List
2 User Details

3 User Privileges
4 Device List
Delete
Add

Save
Close

Display the list of users in Voltsoft.

Clicking on the user name will display the user’s details in
this area. Users can:

- Modify their password

- Assign an expiry date for that user

- Modify the active status for that user.

Control whether the user can access the user management
module or not in the web-based version.

Control which devices are available for the selected user in
the web-based version.

Click on a user in the user list and then the Delete button to
delete an existing user.

Click on the Add button to create a new user.

Save the current user’s information.

Close this module.

N.B. Voltsoft only allowed max. three user exist in the system.

18
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5.2 Email Management

This module allows the user to manage the email addresses of those who will receive email
alerts. To launch this module, click File-=Email Management in the main menu.

\/| Email Management

Following email will receive email alert when device
reading reach certain alen level

E mail &ddres= 1

iohinzmitiEgrail. com

|icuhnsmit@gmail.u:u:um |
L

2 [ Add Flemove 3 ]I Cloze 4
1 Email Address The email address is configured within Voltsoft.
2 Add New Email Input a new email address and click the Add button to add
a new email into the system.
3 Remove Email Click on an email in the email address list and click the
Remove button to remove the email from the system.
4 Close Close this module.

19
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5.3 Email Template

To launch this module, click Preference-=Email Template.

|/ Email Template

Language zh

Subject |‘-.f|:|tsu:|ft [rata Alert

b airnumn Alert Dear Sir/Madam,

The device {DEYICE} has reached the max. alert level on column {COLUMM} at {TIME}, current reading walue
{READIMG}

Pleaze perform any necessary action,

Reqards,
"oltzoft

Pinirnum Alert Dear Sir/Madam,

The device {DEVICE} has reached the min. alert level on column {COLUMMNY at STIME}, curent reading value
{READIMG}

Fleaze perform any necessary action.

Fegards,
“Woltzoft

Drear Sir/Madam,

The device {DEYICE} reached alert level but had been reset on column {COLUMMY at {TIME}, curent reading
value {READING}

Pleaze perform any necessary action,

Reqards,
"oltzoft

1 Language Select the language of the email template.
2 Message Content Fill in the title and content for the email template which will
be sent in the different cases:

Case 1: Maximum Alert
This email will be sent when a reading is higher than the
maximum alarm level.

Case 2: Minimum Alert
This email will be sent when a reading is lower than the
minimum alarm level.

Case 3: Reset Level
This email will be sent when a reading was previously at a
max/min alarm level but has returned to a normal level.

3 Save Click the Save button to save the template.
4 Close Click the Close button to close the module.

20
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Variable

The following labels are defined as variables and will be replaced when sending out.

1 {DEVICE} The device alias

2 {COLUMN} The device reading name

3 {READING} The device reading value

4 {TIME} The time the event happened

5.4 Email Alert

\/ Email flert |:| @Wzl

Recipient|z] List

Following receipient[z] will receive email alert

johnsmitiEgmail. com

ok || Olose

Voltsoft has an email alert feature, which will send out an email to the specified user when the
device reading is above or below a certain level.

The user can use this module to select who will receive the email for the specific device.

21
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5.5 Custom Graph

Custom Graph allows the user to graph the measurement readings from more than one device.
To create a custom graph:

1. Select Device Management->Custom Graph in main menu.

"\/ Custom Graph

Exist Graph [T

2. Select New to create a new graph or select the previous saved graph. Click OK to
continue.
3. The Custom Graph detailed interface will be displayed:

\/ Custom Graph

Graph Mame |Graph 1

Device and Measurement

Data Period PC storage range  Earliest data:  (04-05-2011 0&:50:37 Latest data:  04-05-2011 06:51:23

From: |130620110000 ~ | To: 140620112353 % [ Real Time Data

Device Measurement Selected Measurement

DL101T - Logger 1 miperature 950 - Wolkage [V DC)
DL141TH - 140

DL141TH - 140-2
SL451 - 400 >

Lot a0 N

Y950 - 950
<4

Mest Step > ] [ Save ] [ Firizh l [ Claze

22
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4. Then the user needs to:
I. Select the data period or real-time data (only specific devices support real-time
reading).
I1. Select the device and measurement column.
I11. Click Next Step> to continue.

Graph Mame |Glaph 1 |

teazurement Setting

Selected Measurement

Device I eazurement Data bdas. [rata in. Bz Lz Mas, Az bin, Align Zero
T "1 = =

0 1 - - N

a 1 - - M

Yoltage [ DC)

140 Temperature
140 Dew Point 0

ais @1 Oz misMae | adsMin | | coou [ O #onzeo
[ < Prev Step ] [ Save ] ’ Finizh ] ’ Cloze ]

IV. For each column, the system will show the data maximum and minimum values
for the selected period.

V. For each column, the user can specify whether it is drawn in Y1 or Y2, specify the
Y-axis maximum and minimum values, the corresponding colour of the line or
align the Zero level to the same level or not.

V1. Click Finish to generate the graph.

R
il Gioeh Y
Graph 1
TLOggRT 100] TRmpRTature JLogGRT 130] TempRTalure V] Wl Uty TLoGe VI A Fresaae
o [Logger 160] Sound Level ait JLogger 400] Sound Leved oits 1

4 40 4
1 I
fg o4 —
1% o
1z E
1 :E g

. 4
le £
1E &

3 . |F
1 &0

10 4
b
.\
+ . + . ; "
21858 2208 22 238 25 308
From:11-10-2010 22:00:00 To:11-10-2010 23:00:59

23
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5.6 Web Interface

5.6.1 Using the Voltsoft System (Web)

Voltsoft also provides a web-based interface for the user to control the device through Internet
Explorer (version 7 or 8).

To access the Voltsoft Web interface, please open Internet Explorer (1.E.) on your local
computer and input http://127.0.0.1 or http://localhost. If you change the port number in
General Settings to another port number, then you are required to enter the port number too,
e.g. http://127.0.0.1:8080.

If it is successful the login page will be displayed.

(= YOLTCRAFT - Device Management System - Windows Internet Explorer |:”E”X|

Ge ~ | heoynizro..y 2 [#2] [%] [uwve search |[2]-]
& bt [g\-‘OLTCRAFT-Dewce Management Systern I_l @ = @ o @Eage < @Tgols = =

Dane [ N [ | @ Internet L o#ow v 2

Enter the valid user login created in the user management module.

24
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After login, you will see a main screen similar to the Windows client.

{= VOLTCRAFT - Device Management System - Windows Internet Explorer

—
EIBX
@.\- 5 | E] httpiit127.0.0.1index, st DS |2
— B . »
w oA [@VOLTCRAFT-DEVKE Management System l } - B - @ - [2hpage - G Taoks -
File Device Management Logout

VOLTCRAFT

Data Logger

(© DL-100T - Logger 100
© DL-120TH - Logger120
(© DL-140TH - Logger 140
© DL-1605 - Logger 160
& DL-180THP - Logger 180

(& 5L-400 - Logger 400

Done

e Internet "‘ 100% -

Click on the device entry and you will be prompted to install an ActiveX control issued by CEI
Conrad Electronic International (HK) Ltd. Please click Install to install it.

Internet Explorer - Security Warning [z|

Do you want to install this software?

Mame: DeviceWwebChark, cab

Publisher: CEI Conrad Electronic International (HK} Ltd.

E] Mare opkions Inskall |

Dan't Inskall

‘while Files From the Inkernet can be useful, this file type can potentially harm
wour camputer, Only install software from publishers wou trust, What's the risk?

After the installation, the chart control should be displayed like this:

25
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) DL-100T - Logger 100
© DL-120TH - Logger 120
© DL-140TH - Logger 140
© DL-1605 - Logger 160
© DL-1B0THP - Logger 180

© SL-400 - Logger 400

DL-100T - Logger 100

Temperature(®C)

DL-100T - Logger 100

12 T T T
1.0 q
08 4
0.8 4
04
02
00 t + + t t
0:00:00 12:00:00 18:00:00 00:00:00 08:00:00
01-11-2010 01-11-2010 m-11-2010 02-11-2010 02-11-2010
Time:01-11-2010 14:34:43

1o
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5.6.2 Accessing Voltsoft Web from a Remote Computer

Voltsoft Web allows users to control the device information from a remote computer through
I.E., just like the remote feature of the IP camera. However, the computer may need some
configuration changes in order to allow access to incoming traffic.

1. First, you need to check the IP address of your computer by opening the settings page in
the Windows client or check by using command prompt.

To check by using command prompt, open a command prompt and enter ‘ipconfig’.
e C:\WINDOWSisystem32emd. exe

C:~>ipconfig

Windows IP Configuration

Ethernet adapter Local Area Connection 3:

Connection—specific DHS Suffix

IPF Addres=s. . . . . . 122.168.1.1308
Subnet Mazk . . . . . 255.255.255.8
Default Gateway . . . A I s |

For example, your IP address is 192.168.1.130 in the above example.

2. Secondly, check your firewall settings. Go to Control Panel, and click on Windows Firewall.

27
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%= Windows Firewall

Gereral | Exceptions | &dvanced

Windowsz Firewall helps protect your computer by preventing unauthorized users
from gaining access to your computer through the Internet or a nebwaork.

@ O On [recommended]

This zetting blocks all outside sources from connecting to this
camputer, with the exception of thoze selected on the E=ceptions tab.

Select thiz when you connect to public networks in less secure
locations, such az airports. vou will not be notified when Windows
Firewall blocks programs. Selections on the Exceptions tab will be
ignored.

@ ()0ff [not recommended}

Avoid uzing this setting. Turning off Windows Firewall may make this
computer mare vulherable ta viruzes and intruders.

‘wihat else should | know about Windows Fiewall?

[ Ok. ][ Cancel ]

3. For testing, you can turn off your firewall. Or you can also configure the firewall by
allowing an exception. For details, please contact your network administrator.

4. Then you can try to access the Voltsoft Web through another computer on the same
network. E.g. in the above case, you should input http://192.168.1.130 in I.E. If you have
any problems, please contact your network administrator to check the network
connectivity between the two computers.

5. You may access Voltsoft Web through the Internet from a remote site office, however you
will be required to provide the network settings of your computer to your network
administrator in order for him/her to configure your company router and firewall.

28
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5.6.3 Using the Voltsoft System (Web)

The interface of the Web client will be very similar to the Windows-based client.

i. Login Screen

English %

29
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ii. Main Screen

File Device Managernent Layout Logout o]
Data Logger - DL101T- Logger 1 [/
© DLL4ITH - 140 Sects G —
. Dat: ]l Graph
(&) DL141TH - 140-2 V.
. PC storage range Eatliest data: 04-03-2011 0630037 Latest data: 04-05-2011 06:51:23 —
® sLasl- 40 [ summay
@ pLioiT- Loggerl Meazuremert Maximum alue Mimimum % alue Average Value
Tempersture (*C) i) 233 288
All Data Expart CSV ] [ Expart Excel
Record Time Temperature (*C) A
04-05-2011 06:50:37 258
04.05-2011 06:50:39 288
04-03-2011 06::50:41 288
04-05-2011 06:50:43 258
04-05-2011 06:50:45 258
04-03-2011 065047 288
04-05-2011 06:50:49 258
04-05-2011 06:50:51 258
04-03-2011 06:50:53 206 L
04-05-2011 06:50:55 258
04-05-2011 06:50:57 258
04-05-2011 06:50:59 288 o |
04-05-2011 06:51:01 258
04-05-2011 06:51:03 258 B
04-05-2011 06:51:05 288 e
-l
IFi} /" Trusted sites Yo v 0% -
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Screen Layout

One of the most significant differences between the Windows version and the Web version is
that you can arrange the Web version’s device windows into three different layouts: 1) Single
Column, 2) Two Columns, 3) Tab Layout

1) Single Column

File Davice Managemant Layout Logout

Device  Graph
&) DL141TH - 140

Data |[ h 1‘

(@ DLLLTH - 140-2
DL101T - Logger 1

(@ 5L451- 400
]
2 DLAT - Logger 1 30 T

25 4

20

Temperature(*C)
B

5 4
0 } } t
DB:80:32 06:50:47 06:51.02 088117
04-05-2011 04-05-2011 04-05-2011 04-05-2011
Time
< o
< B3

mm—ﬁﬁ]

Davice  Graph

Data | h |

| SL451 - 400 \
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2) Two Columns

© DLLAITH - 140
© o PC storage range Earliest data: 04-05-2011 08:50:37 (et iy @ 521) SLast- 400
© sLést-400 06:51:23 s TTwE . .
) DLL0IT - Lagger 1
_ [ ExportC8v | [ Export Excel |
10
Record Time: Temperature (°C) Ll
04-05-201 1 06:50:37 268
04-05-201 1 0B:50:39 288 08
04-05-201 1 0B:50:41 28
04-05-2011 06:50:43 23 3
04-05-2011 06:50:45 23 SN
04-05-2011 06:50:47 288 é
04-05-201 1 06:50:49 268 = ¢
04-05-2011 0B:50:51 28
04-05-2011 06:50:53 23 o*
04-05-2011 06:50:55 23
04-05-2011 06:50:57 23
04-05-2011 0650159 288 02
04-05-2011 0B:51:01 288
04.05-201 1 0B:51:03 28
04-05-2011 06:51:05 23 oo Ly + t t
04052001 085107 28 W o0zt Bonzoi woszoin onzsi onzin
04-05-2011 06:51:09 288 Tirne
04-05-2011 06:51:11 268 I J—‘
04-05-201 1 DB:51:13 288
Q4 02 on1a et R

© pL121TH - 121

(@ DLL4ITH - 141

Earliest data: 18-07-2011 05:55:15 Latest data: Current Time:

Earliest data: Ni& Latest data: Mg

PC starage range PC starage range

© DL1ALs- 161

@ sLast- 451

Real Time Mode All Data Export CBV Export Excel

Record
Time

© sLast- 4512

© sLas1- 4513 Reading Unit Function Made . Record Time Tempersture (°C) Relative Humidity (%) Dew Paint (°C) ‘

2011 228 "G Temp. -

05:12:48
2 e -930 0

o

© weeso -vas
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2) Tab Layout
File Dewice Managerment Layout Logout
Data Logger DLA0AT- Logger 1.5 | SL451- 400 ()
© DLIITH - 140 BoiE Gl
Data Graph
© DLLITH - 140-2
. DL101T - Logger 1
© sL451- 400
2 DLA0IT - Logger 1 12 T
DMM
104
~ 08
(3]
<
2
2
§ 05
@
a
3
@
" o4
02 4
oo t t t t t
15:00:00 21:00:00 03:00:00 09:00:00 15:00:00
16-06-2011 16-06-2011 17-06-2011 17-06-2011 17-06-2011
Time
[« 1+

5.6.4 Limitation in Web Version

Although the interface and function of the Web version is very similar to the Windows version,
they have some differences as following:

1) The Web version is targeted to those users who are not in front of the computer which is

connected to the device; therefore, the “Add and Remove Device” function will not be available
in the Web version.

2) The Web version will not auto refreshed in some areas (when compared with the Windows

version), so users are required to press “F5” or the “Refresh” button in the browser tool bar on
the interface. These areas are:

i. Device list

ii. Real-time / Display status for VC930 or VC950
iii. Real-time / Display status for VC850 or VC650BT
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6 Supported Devices

Voltsoft currently support following devise:

Type Device Name
Data Logger DL101T

Data Logger DL111K

Data Logger DL121TH

Data Logger DL131G

Data Logger DL141TH

Data Logger DL141TH2K
Data Logger DL151AN

Data Logger DL161S

Data Logger DL181THP
Data Logger DL191A

Data Logger DL191V

Data Logger DL200T

Data Logger DL201THM
Data Logger DL210TH

Data Logger DL220THP
Data Logger IR 1200-50D
Data Logger PL-125-T2USB / PL-125-T4USB
Data Logger SL451

DMM VC930 / VC950
DMM VC880 / VC650BT
DMM VC890

EL4000 EL4000
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6.1 DL101T

DL101T is a data logger for storing temperature reading.

6.1.1 Add new DL101T
When Voltsoft detects a new DL101T attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it inko the system now?

Click “Yes”, the following dialog will be displayed:

\/ fudd New Device

Device Series |Data Logger

Model Mumber | DL101T

Alias 101T]

[.ﬂ'-.utu:u-Detect ] [ Add ] [

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by select Device Management-=>Add New Device in menu.

6.1.2 Remove DL101T

To remove DL101T, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.1.3 DL101T — Device Control Panel
A DL101T - 101 - X
Device  Graph
,"I Data \ Graph "'.II
PC storage range Earliest data:  09-01-2013 22:42: 27 Latest data:  10-01-2013 16:29:03
2 Summary
Meazuremnent Maximum wWalue Minimum s alue Average Value
Temperature [*C)
All Data Euport Excel ] [ Erport C5Y
Record Time Temperature [*C)

The DL101T Device Control Panel contains follow items in menu:

1 Device -> Settings

2 Device -> Download Data

3 Device -> Display / Plot Data
4 Graph -> Plot Colour

5 Graph -> Background Colour
6 Graph -> Grid

7 Graph -> Line

8 Graph -> Points Indicator

9 Graph -> Print

10 Graph -> Save Image As

11 Graph -> Zoom Out
12  Graph -= Zoom To Fit

This will launch the setting page of DL101T.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.1.4 DL101T - Settings

\/101T - Settings (HW ID:01_1210170003)

Basic Settings

4 Time Use System Time
Logger Mame 1mT
Record Start Condition ) By Button () After Setup
sample Paints 32000 w sample Hate 25 w
Recarding Time 17 Hours 46 Minutes 40 Seconds
LED Flash Cycle ) 10s ) 20s O 30s

Alarm Settings
[] Enable LEDs Alert

Termperature Low Lirmit -40.0 2 0 % High Limit 700 %) RC

Device connect,

Drefauilt ] [ Setup l [ Cloze
1 Time Configure the device data time value.
The user can specify a defined time or use the system
date time.
2 Logger Name Input the unique alias for that device.
3 Record Start Condition By Button — The data logger will start recording only

after the user pressed the red button on the device.

After Setup — The data logger will start recording
immediately after setup.

4 Sample Points Instruct the logger to take a finite number of readings.

5 Sample Rate Instruct the logger to log readings at a specific rate.

6 Recording Time Calculate the recording time based on the selected
sample points and sample rate.

7 LED Flash Cycle Configure the LED flash cycle - the longer the time, the
longer the battery life.

8 Enable LED Alert Enable / disable LED flash when the alarm is triggered.

9 Temperature Low / High Configure the temperature low / high alarm level.

Alarm

10 Default Button Reload the factory default settings.

11 | Setup Button Save changes.

12 | Close Button Close this interface.

Note: Any stored data will be permanently erased when setup is finished.
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6.1.5 DL101T - Download Data

This module allows user to download the data from DL101T.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.1.6 DL101T — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplap/Plot D ata

() PC storage range Earliest data: M4 Latest data; MAS

) From: 03-12-2012 16:22:34 hd To: (10122012 17.22.34 hd

Device connect.

[ ok | [ Cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 will be returned.)
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6.1.7 DL101T — Data View

DL101T contains one measurement (Temperature) only, its unit can be Celsius or Fahrenheit,
depending on the setting in general setting.

Device  Graph

PLC storage range Earliest data: 01-11-201 2 16:23:13 Latest data: 02-11-2012 01:31:29

¥ Sumrary

All Data E=port Eucel ] [ E part C5Y

Record Time Temperature (*C) ~

01-11-2012 16:56:03 254

01-11-2012 16:56:05 254

01-11-2012 16:56:07 254

01-11-2012 16:56:09 254

01-11-2012 16:56:11 254

01-11-2012 16:36:13 254

01-11-2012 16:56:15 254

01-11-2012 16:56:17 254

01-11-2012 16:56:19 254

01-11-2012 16:56: 21 254

01-11-2012 16:36:23 254

01-11-2012 16:36:25 254

01-11-2012 16:36:27 254

01-11-2012 16:56:29 254

01-11-2012 16:56:31 254

01-11-2012 16:56:33 254

01-11-2012 16:56:35 254

01-11-2012 16:36:37 254

01-11-2012 16:36:39 254

01-11-2012 16:56:41 254

01-11-2012 16:56:43 254

01-11-2012 16:56:45 254

01-11-2012 16:56:47 254

01-11-2012 16:36:49 254

01-11-2012 16:56:51 254

01-11-2012 16:56:53 254

01-11-2012 16:56:55 254

01-11-2012 16:56:57 254

01-11-2012 16:56:59 254

01-11-2012 16:57.01 254

01-11-2012 16:37:03 254

01-11-2012 16:37:05 254

01-11-2012 16:57:07 254

01-11-2012 16:57:09 254

01-11-2012 16:57:11 254

01-11-2012 16:57:13 254 I
1 Export Excel Export the reading to Excel (.xlIs) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.1.8 DL101T — Graph View

Temperature(°C)

[ > Temperature |

DL101T -1011

249005 +

24.9000

248995

348990 |

248985 -

17:42:49
01-11-2012

17.44:04
01-11-2012
Time: 01-11-2012 17:44:23 Temp.:24.9(°C)

174419
01-11-2012

Our graph support following operations

1

2
3
4

Mouse wheel

Mouse click and drag
Shift + mouse click
Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values

6.1.9 DL101T — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL101T is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.2 DL121TH

DL121TH is a data logger for storing temperature and humidity reading.

6.2.1 Add new DL121TH
When Voltsoft detected a new DL121TH attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want ko add it into the swskerm now?

Click “Yes”, the following dialog will be displayed:

\/ #dd Hew Device

Device Seties |Data Loager

Model Mumber  DL121TH v/

Alias 121TH| |

[.ﬁ.utD-Detect ] [ Add l [ Cloze ]

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management-=>Add New Device in menu.

6.2.2 Remove DL121TH

To remove DL121TH, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.2.3 DL121TH — Device Control Panel

A DL1Z21TH-121

Device  Graph

{ Data \

Graph "'.II

PC storage range

Earliest data: 09-01-2013 22:43:10

Latest data: 10-01-2013 07:36: 238

Measurement Maximum Yalue
Temperature [*C)
Relative Humidity (%)

Drewy Paind (*C)

Minimum Y alue Average VYalue

All Data

Record Time Temperature [*C)

DL121TH contain follow items in menu:

1 Device -> Settings
2 Device -> Download Data

3 Device -> Display / Plot Data

4 Graph -> Plot Colour

5 Graph -> Background Colour

6 Graph -> Grid
7 Graph -> Line
8 Graph -> Points Indicator
9 Graph -> Print
10 Graph -> Save Image As

11 Graph -=> Zoom Out
12 Graph -> Zoom To Fit

Export Excel ] [ Ewport C5Y

Relative Humidity (95) D Point (77

This will launch the setting page of DL121TH.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.2.4 DL121TH - Settings

10

11
12
13

\/121TH - Settings (HW ID:02_1211070004)

Basic Settings

Tirme

Lagger Mame

Fecord Start Condition
sample Paints
Recording Time

LED Flash Cycle

Alarm Settings
[] Enable LEDs Alert

Device connect.

Termperature Lo Lirnit -40.0 2 | °C High Limit J00 %) oC

Relative Humidity  Low Limit 00 2 %  High Limit 0.0 s %

Use System Time

121TH
() By Buttan ) After Setup
16000 v Sample Hate |25 v

8 Hours 53 Minutes 20 Seconds

) 103 ) 205 ) 20s

Drefault ] [ Setup l [ Cloze

Time

Logger Name
Record Start Condition

Sample Points
Sample Rate
Recording Time

LED Flash Cycle

Enable LED Alert
Temperature Low / High
Alarm

Relative humidity Low /
High Alarm

Default Button

Setup Button

Close Button

Configure the device data time value.

The user can specify a defined time or use the system
date time.

Input the unique alias for that device.

By Button — The data logger will start recording only
after the user presses the red button on the device.

After Setup — The data logger will start recording
immediately after setup.

Instruct the logger to take a finite number of readings.
Instruct the logger to log readings at a specific rate.
Calculate the recording time based on the selected
sample points and sample rate.

Configure the LED flash cycle - the longer the time, the
longer the battery life.

Enable / disable LED flash when the alarm is triggered.
Configure the temperature low / high alarm level.

Configure the humidity low / high alarm level.
Reload the factory default settings.

Save changes.
Close this interface.

Note: Any stored data will be permanently erased when setup is finished.
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6.2.5 DL121TH - Download Data

This module allows user to download the data from DL121TH.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.2.6 DL121TH — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplap/Plot D ata

() PC storage range Earliest data: M4 Latest data; MAS

) From: 03-12-2012 16:22:34 hd To: (10122012 17.22.34 hd

Device connect.

[ ok | [ Cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 will be returned.)
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6.2.7 DL121TH — Data View

DL121TH contains three measurements (Temperature, relative humidity and dew point),
template / dew point unit can be Celsius or Fahrenheit, depending on the setting in general
setting.

Device  Graph

f Data \
FC storage range Earliest data: 10-10-2012 15:40:32 Latest data:  11-10-2012 00:33:56
¥ Summam
All Data Export Excel ] [ Expart C5Y
Record Time Temperature (*C) Relative Humidity (%) Dy Point (*C)
10-10-2012 15:40:38 261 44 2 12497
10-10-2012 15:40:40 261 44 2 12497
10-10-201215:40:42 261 442 12597
10-10-2012 15:40:44 261 442 12597
10-10-2012 15:40:46 2641 442 1297
10-10-2012 15:40:45 2641 442 1297
10-10-2012 15:40:50 261 44 2 12497
10-10-2012 15 40:52 261 44 2 12497
10-10-2012 15:40:54 261 441 1283
10-10-2012 15:40:56 261 441 1283
10-10-2012 15:40:55 2641 441 1293
10-10-2012 15:44:00 2641 441 1293
10-10-2012 15:44:02 261 440 1240
10-10-2012 15:41:04 261 440 1240
10-10-201215:41:06 261 440 12480
10-10-201215:41:05 261 4349 1286
10-10-2012 15:41:10 2641 439 1286
10-10-2012 15:41:12 2641 439 1286
10-10-201215:41:14 261 4349 1286
10-10-2012 15:41:16 261 4349 1286
10-10-201215:44:18 2641 439 1286
10-10-201215:41:20 261 4349 1286
10-10-2012 15:41:22 2641 439 1286
10-10-2012 15:41:24 2641 439 1286
10-10-2012 15:41:26 261 439 1286
10-10-201215:41:28 261 4349 1286
10-10-2012 15:44:30 261 4349 1286
10-10-201215:41:32 261 4349 1286
10-10-201215:41:34 261 439 1286
10-10-2012 15:41:36 2641 439 1286
10-10-2012 15:41:38 2641 439 1286
10-10-2012 15:41:40 261 4349 1286
10-10-2012 15:41:42 261 4349 1286
10-10-201215:41:44 261 4349 1286
10-10-2012 15:41:46 261 438 1283
10-10-2012 15:41:48 2641 43.7 1279

1 Export Excel Export the reading to Excel (.xlIs) format.

2 Export CSV Export the reading to Excel (.csv) format.
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6.2.8 DL121TH — Graph View

Device  Graph
I Data / Graph \

DL121TH - DL121TH
[ % Temperature Relative Humidity  x Dew Point
1 a5
FRHR e
25 + I
4 40
g |
E [ —
& 1as &
2 £
v 20 + =
] E
o F,F
EE. + 30 g
2 &
2 ®
o 1S
o L
E 15 + + 25
|_ L
A ;,;g %M 4 L
- 20
10 T . . } . . } } } t t } . . } } }
15:44:00 15:45:00 15:46.00 154700
10-10-2012 10-10-2012 10-10-2012 10-10-2012
Time: 10-10-2012 15:47:12 Temp.:26(°C) RH:43.8(%) DP:12.74(°C)

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.2.9 DL121TH —Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL121TH is the same as Windows version, except the downloaded data
can only have 10,000 reading in a single download.
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6.3 DL131G

DL131G is a data logger for storing vibration reading. DL131G supports real time and real
time Fast Fourier Transform (FFT) measurement.

6.3.1 Add new DL131G
When Voltsoft detected a new DL131G attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it inko the system now?

Click “Yes”, following dialog will be displayed:

\/ Add New Device A=

Device Series |Data Logger v|

Model Number  [TREIE

Alias | |

Auto-Detect ] [ Add l [ Cloze ]

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.3.2 Remove DL131G

To remove DL131G, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.3.3 DL131G — Device Control Panel

< DL131G- 178

Device

-

Graph

/

PLC storage range

D ata \

Graph I"\

Earliest data:  11-10-2013 13:14:05

Latest data:  13-10-2013 221227

Measurement

Maimum Yalue

binimum * alue

Average Value

All Data

FFT:

Record Time X Value W Walue

Export Excel ] [ Export C5Y

I Value “ector Sum

The DL131G Device Control Panel contains follow items in menu:

A WN PP

u

10
11
12
13
14

Device -> Settings

Device -> Stop

Device -> Download Data
Device -> Display / Plot Data

Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As
Graph -> Zoom Out

Graph -> Zoom To Fit
Graph -> View All Data

This will launch the setting page of DL131G.
Stop the real time data download.

Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.

Zoom out the graph to view all data.
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6.3.4 DL131G — Settings

\/ 178 - Settings (HW ID:78a_121123000002)

B azic Settings
Time Usze Spztern Time
Logger Mame 178
Sarnple Rate a0 2 ms v
LED Flash Rate (10 (20 (O30 (O Disable
Condition for recaording start () By Button (+) After Setup
hotion Detection Threshold Setup Recording Mode
# Threshold 2 w
g ) Momal
" Threshold 2q hd
{(*) Motion D etection
ZTveshold T
Devics connect [ Drefault ] [ Setup ] [ Cloze

1 Time Configure the device data time value.

User can specify a defined time or use the system date
time.

2 Logger Name Input the unique alias for that device.

3 Sample Rate Instruct the data logger to log readings at a specific

rate.

4 LED Flash RateCycle Configure the LED flash cycle - the longer the time, the

longer the battery life.

5 Record Start Condition By Button — The data logger will start recording only
after the user pressed the red button on
the device.

After Setup — The data logger will start recording
immediately after setup.

6 Motion Detection Threshold The Motion Detection Threshold Setup filed allows the

Setup user to set the acceleration detection threshold.Once
the acceleration value is over the threshold,the
DATALOGGER will work.

7 Recording Mode The DATA LOGGER Record Mode can be set as Normal

and Motion Detection.

8 Default Button Load the factory default settings.

9 Setup Button Save changes.

10  Close Button Close this interface.
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6.3.5 DL131G - Download Data

This module allows user to download the data from DL131G.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.3.6 DL131G — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

6

Display/Plot Data
Dizplay/Plat D ata

() PC storage range
%) From:

) Real Time Data

() Feal Time FFT

Device connect.

Eo)x]

Earliezt data:  11-10-201313:14:05 Latest data:  13-10-2013 221227
2310-201311:25:58 W To: | 30102013 12:25:59 w
| ok || close

PC Storage Range
Time Range
Real Time Data

Real Time FFT
OK

Cancel

Download all data stored in the database.

Select the data reading range.

Download real time data, will only enable if the device
in real time mode.

Read real-time spectral data for FFT analysis.

Click OK to accept the input and display the selected
reading in the data and graph tabs.

Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.3.7 DL131G — Data View

DL131G contains four measurements (X Value, Y Value, Z Value and Vector Sum).

< DL131G- 178 -

Device  Graph
(( D ata \ Graph \

PC storage range Earliest data:  11-10-2013 13:14:05 Latest data:  13-10-2013 22:12:27

Meazurement Macimum alue Minimum % alue Average Yalue

All Data FFT: Export Excel ] [ Export CSY

Record Time X Value W Walue I Value “ector Sum
|
1 Export Excel Export the reading to Excel (.xlIs) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.3.8 DL131G — Graph View

< DL131G - 131

Device

araph

Graph \

Data y

Acceleration

DL131G - 131

[ < XValue

¥ Walle % ZWalue Wector Sum |

1.5

10 +
05 +

0.0

-05 -:-

-1.0 |

15 4 : . .

20:43:21 20:43:36
14-11-2013 14-11-2013

: 1 y ' T y ' 1
20:43:51 20:44:06 20:44:21
14-11-2013 14-11-2013 14-11-2013

Our graph support following operations

1

2
3
4

Mouse wheel

Mouse click and drag
Shift + mouse click
Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values
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6.3.9 DL131G — Real Time FFT

The logger will enter real time FFT mode when select “Real Time FFT” in “Display / Plot Data”.

In FFT mode, there is two options for displaying data: Time Domain and Frequency Domain.

Time Domain:

In time domain mode, total 128 reading will be download at any specific period of time.

DLING - 170

- %

Devce  Graph
Il Data |\ Graph \
I
FL slorage targe Eabest dola 1110013131405 Lotect deta 13102013 229227
% Summaty
1
| Al Data FET: (3} Tane Devicen (2} Faruericy Do L Pl e Jl L J
| Rncoed Time K Vinlue ¥ Vinlue I Vialue iector Sum ~
|| 30102013 1207 45879 0x 080 044 096
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0102013 120745891 008 088 002 088
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| nns nes an? nga
LE o o oo o
0N 10745 o o o oy
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A DL131G-131 - X
Device  Graph
| Data Graph
DL131G - 131
[ < XWalue Y Value »  ZValue Vector Sum |

2.0 .

15 -

1.0 -

05 -

0.0
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-0.5 -
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Frequency Domain:

readings to display.

~ DL131G- 178

In frequency domain mode, the 128 reading downloaded will be calculate and transform to 256

Device  Graph

/

PL storage range

Earliest data: 11-10-2013 13:14:05

Data

\{ Graph "‘-\

Latest data: 13-10-2013 2212:27

¥ Summary
All Data FFT. (3 Time Domain’ G Frequency Domain Export Encel EvpotCsY_ |
Frequency X Walug ¥ Walue 7 Walug -~
0 1242 14545 995
1 490 6290 394
2 29 2861 275
3 050 288 073
4 1.90 1580 1.44
E [iierd 11.30 080
B ns9 327 0.34
7 n4s 859 113
8 080 614 016
E) nzr 225 019
10 047 6.80 067
" 1.34 402 036
12 110 268 o7s
13 1.40 546 047
14 026 206 o
15 043 151 025
16 119 438 083
17 0a3 285 1.54
18 143 274 093
19 222 4.40 210
20 173 1.30 1.55
2 060 256 056
22 041 410 on
23 037 086 1.55
24 n1g 218 ovs
25 030 257 o7e
26 080 0.31 028
27 0a1 208 0.34
28 062 238 0.52
29 064 059 036
30 1.34 206 082
3 1.00 274 a7
32 094 1.3 oa7
33 022 1.80 RE]
34 014 173 014 .
. S DL1I31IG-131 - M
Device  fraph
."I D ata f Graph
DL131G - 131
[ = HXWalue YValue  x ZValue |
“" V¥
120 £
% 1
s 100 +
:I: 3
= ]
gj J
E 80 T
I I
otg ]
~ 60 4
= k
=
':I 1 T
=
0 50 100 150 200 250 300
Frequency: 249 X Value: 4.75 Y Value: 6.00 Z Value: 8.18
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6.4 DL141TH

DL141TH is a data logger for storing temperature and humidity readings.

6.4.1 Add new DL141TH
When Voltsoft detected a new DL141TH attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want ko add it into the swskerm now?

Click “Yes”, the following dialog will be displayed:

\/ Add Hew Device

Device Series |Data Logger v|
Model Murnber  DL141TH v
Alias 141TH| |

[.ﬁ.utD-Detect ] [ Add l [ Cloze ]

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->=Add New Device in menu.

6.4.2 Remove DL141TH

To remove DL141TH, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.4.3 DL141TH — Device Control Panel
< DL141TH- 141TH * X
Device  Graph
X Data \ Graph "'.\
PC storage range Earliest data:  15-12-2012 16:29: 44 Latest data:  19-12-2012 16:29:52
{ % Sumnmany
|| Meazurement hazimum Yalue inimum “alue Mverage Value
Temperature (")
Relative Humidity (%)
Dy Poirt ()
All Data Export Excel ] [ Export C5Y
Record Time Temperature (*C) Relative Humidity (%) Drewy Paint (#C)

The DL141TH Device Control Panel contains the following items in menu:

1
2
3

10
11
12

Device -> Settings
Device -> Download Data

Device -> Display / Plot Data

Graph -> Plot Colour

Graph -> Background Colour

Graph -> Grid
Graph -> Line
Graph -> Points Indicator
Graph -> Print
Graph -> Save Image As

Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of DL141TH.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.4.4 DL141TH — Settings

10
11
12
13

\/ Logger 140 - Settings

Device Time

Basic Settings

Logger Name

Record Start Condition
Sampling Rate
Recording Time

LED Flash Cycle

Recording

Alarm Settings
Enable LEDs Alert

Temperature

Relative Hurnidity

Device connect.

Use System Time

Logger 140

O By Button (5) After Setup

10 &ils o
1 Day 21 Hours 25 Minutes

) 10s O 20s QO 30s O Disable

O Circulating Record (%) No Circulating

Low Level -400 2 °C  High Level 700 I °C

LowLevel 00 3| %  High Level 100.0 3| %

[ Default J[ Setup }[ Close ]

Device Time

Logger Name
Record Start Condition

Sample Rate

Recording Time
LED Flash Cycle

Recording

Enable LED Alert
Temperature Low / High
Alarm

Humidity Low / High Alarm
Default Button

Setup Button

Close Button

Configure the device data time value.

User can specify a defined time or use the system date

time.

Enter the unique alias for that device.

By Button — The data logger will start recording only
after the user presses the red button on
the device.

After Setup — The data logger will start recording
immediately after setup.

Instruct the data logger to log readings at a specific

rate. The user can input specific data in the edit box on

the left and select the time unit using the combo box
on the right.

Calculate the recording time based on the selected

sample points and sample rate.

Configure the LED flash cycle - the longer the time, the

longer the battery life.

Instruct the data logger to continue logging data,

recording over the earlier data (Circulating Record), or

to stop logging (No Circulating) when the data logger
memory is full.

Enable / disable LED flash when the alarm is triggered.

Configure the temperature low / high alarm level.

Configure the humidity low / high alarm level.
Reload the factory default settings.

Save changes.

Close this interface.
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6.4.5 DL141TH - Download Data

This module allows user to download the data from DL141TH.

Download Data Q@@

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.4.6 DL141TH - Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplap/Plot D ata

() PC storage range Earliest data: M4 Latest data; MAS

) From: 03-12-2012 16:22:34 hd To: (10122012 17.22.34 hd

Device connect.

[ ok | [ Cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 will be returned.)
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6.4.7 DL141TH — Data View

DL141TH contains three measurements (Temperature, relative humidity and dew point),
template / dew point unit can be Celsius or Fahrenheit, depending on the setting in general
setting.

" DL141TH - 141TH

Device  Graph

PC storage range

Data

Earliest data:  15-10-2007 15:26:34

\..

Graph

Latest data:  15-10-2007 15:29:37

Meazurement Maximurm “alue
Temperature (*C) 52

Relative Humidity (%5) 49.3

Cewy Paint (*C) 13.27

binimum Yalue
246

46.5

1293

Ayerage Value
2500
47 .56
1308

All Data
Record Time Temperature (*C)

15-10-2007 15:26:34 246
15-10-2007 15:26:35 245
15-10-2007 15:26:36 2456
15-10-2007 15:26:37 245
15-10-2007 15:26:35 2456
15-10-2007 15:26:39 246
15-10-2007 15:26:40 245
15-10-2007 15:26:41 2456
15-10-2007 15:26:42 245
15-10-2007 15:26:43 2456
15-10-2007 15:26:44 247
15-10-2007 15:26:45 27
15-10-2007 15:26:46 247
15-10-2007 15:26:47 27
15-10-2007 15:26:45 247
15-10-2007 15:26:49 247
15-10-2007 15:26:50 27
15-10-2007 15:26:51 247

Relative Humidity (%)
483
493
492
492
491
431
490
49.0
459
4549
455
438
45.8
455
45.8
455
457
457

Dieey Point (*C)
15327
1327
1324
1524
1321
1321
1318
1318
153135
13135
1321
15321
1321
1321
1321
1321
1318
1318

Export Excel

Export C5%

1 Export Excel
2 Export CSV

Export the reading to Excel (.xls) format.
Export the reading to Excel (.csv) format.
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6.4.8 DL141TH — Graph View
DListTH- a1 | v x

Device  Graph
| Data 7 Graph \
! DL141TH - 141TH
[ Temperature Relative Hurnidity = Dew Point |

30 T T T T T T T T 50

25 4+
—_ + 40
[&] |
|-
e
E —_
5 o0 §
% + 30 5
2 :
o e T
5 2
é + 20 B
LR :
2 j
E
@
= -+ 10

5 1

0 t t t } t * * f t t t } t t t 0

15:26:00 15:27:.00 15:28:00 15:29:00 15:30:00

15-10-2007 15-10-2007 15-10-2007 156-10-2007 15-10-2007

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.4.9 DL141TH — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL141TH is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.5 DL161S

DL161S is a data logger for storing sound level reading. DL161S supports real time
measurement.

6.5.1 Add new DL161S
When Voltsoft detected a new DL161S attached, the following dialog will be popped up:

Device Management System

Mew device detected, dao wou want ta add it inka the swstem now?

Click “Yes”, following dialog will be displayed:

\/ #dd Hew Device

Device Series |Data Logger

Model Number | DL1E1S

Alias 1615

[.ﬁ.utn-Detect ] [ Add l [ Cloze ]

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.5.2 Remove DL161S

To remove DL161S, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.5.3 DL161S - Device Control Panel
-~ DL1615 - 1615 - X
Device  Graph
/ Data \ Graph "'.‘
PC storage range Earliest data: WA Latest data:  MAa
n Sumrary
Messurement Mac<imurn “alue inimum “alue Average Value
Sound Level dBa,
Sound Level dBC
All Data Export Excel ] [ Expaort CSY

Record Time

Sound Level dBA

Sound Level dBC

The DL161S Device Control Panel contains follow items in menu:

A WN R

al

10

11

12
13
14
15
16

Device -> Settings

Device -> Stop

Device -> Download Data
Device -> Display / Plot Data

Device -> Email Alert

Device -> Calibration
Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As
Graph -> Zoom Out

Graph -> Zoom To Fit
Graph -> View All Data

This will launch the setting page of DL161S.
Stop the real time data download.

Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the email alert module.
(Available in Professional version only)
Launch the calibration module.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.

Zoom out the graph to view all data.
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6.5.4 DL161S — Settings

absh wN

10

11

12

\/ 160 - Settings

Basic Settings
Tirne
Logger Name
Sound Unit
Measuring Speed
Mode Setup
Sample Rate
Sample Points
Recording Time
LED Flash Cycle
Record Start Condition
Storage Setup

Alarm Settings
Enable LEDs Alert

Sound Level

Sound Level

Device connect.

LowlLevel 30 2| dBA High Level (130 2 dBA
Lowlevel 30 | dBC High Level |130

Usge System Time

160

© dBA O dBC
() Fast () Slow
) Peak ) Normal
1 Eils v

Infinite
1 Day 12 Hours 5 Minutes 20 Seconds
©10s O20s ©O30s O Disable
By Button (5) After Setup
() Store ) Real Time

>

dBC

<)

[ Default ” Setup H Close ]

Time

Logger Name

Sound Unit

Measuring speed
Record Start Condition

Sample Rate

Sample Points
Infinite

Recording Time
LED Flash Cycle

Logger Mode

Storage Setup

Configure the device data time value.

User can specify a defined time or use the system date

time.

Input the unique alias for that device.

The sound unit can be dBA or dBC.

The measuring speed can be Fast or Slow.

By Button — The data logger will start recording only
after the user pressed the red button on
the device.

After Setup — The data logger will start recording
immediately after setup.

Instruct the data logger to log readings at a specific

rate.

Configure the data logger sample points.

For real time mode only, the download will not stop

until the user stopped the download.

Calculate the recording time based on the selected

sample points and sample rate.

Configure the LED flash cycle - the longer the time, the

longer the battery life.

Manual — The data logger will start recording only
after the user presses the red button on
the device.

Instant — The data logger will start recording

immediately after setup.
Storage can be Store or Real Time.

Store — The data will be stored in offline mode.
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Real Time — The data will be stored in real time

mode.
13 LED Flash for High / Low Enable / disable LED flash when the alarm is triggered.
Alarm

14  Low / High Alarm for dBA Configure the sound level (at unit dBA) for the low /
high alarm level.

15 Low / High Alarm for dBC Configure the sound level (at unit dBC) for the low /
high alarm level.

16 Default Button Load the factory default settings.

17 Setup Button Save changes.

18 Close Button Close this interface.

6.5.5 DL161S - Download Data

This module allows user to download the data from DL161S.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel ]

Click “OK” button to stop the recording and start downloading.

6.5.6 DL161S — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplay/Plat Data
() PC Starage Rangs Earliest data: A4 Latest data: Currert Time

() Fram: 26-01-201317:38:17 v Ta: | 27-01-2013 18:38:17 v

") Real Time Data

Device connect.

| ok || Cose |

1 PC Storage Range Download all data stored in the database.

2 Time Range Select the data reading range.

3 Real Time Data Download real time data, will only enable if the device
in real time mode.

4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.5.7 DL161S — Data View

DL161S contains two measurements (sound level in dBA and sound level in dBC), the device
can record only one measurement at any specific unit of time (Control in Setting).

< DL161S - 1615 v X

| Device Graph

Data \ Graph "'.\
PC storage range Earliest data:  27-01-2013 18:20:24 Latest data:  Current Time
% Summary
I Messurement Pacimum W alue inimum “alue Average Value
Sound Level dBa T01 928 9973
Sound Level dBC
All Data Export Excel ] [ Export CSY
Record Time Sound Level dB& Sound Level dBC ~
27-01-20135 15:20:24 5.1
27--2013 1820025 aG1
27-01-201318:20:26 550
27-01-2013 1820027 936
27-01-2013 1820028 538
27-01-20135 15820029 267
27-01-2013 1820050 a6.7
27-01-2013 182003 a7 4
27-01-2013 1820052 ary
27-01-201318:20033 534
27-01-2013 1820034 vy
27-0-2013 1820035 562
27-01-2013 15820036 534
27-01-2013 1820057 928
27-01-201318:20038 544
27--20M3 1820039 245
27-01-2013 18:20:40 560
27-01-20135 1582041 6.0 iV
1 Export Excel Export the reading to Excel (.xIs) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.5.8 DL161S — Graph View

~ DL1B15 - 1615

Device

Graph

Data

Graph \

Sound Level

27-01-2013

DL161S - 1618

[ < SoundLevel dBA

Sound Level dBC |

75

70
65 |
60

55 |

50 I

18:20:14

18:20:44

27-01-2013

18:21:14 18:21:.44
27-01-2013 27-01-2013
Time

Our graph support following operations

1

2
3
4

Mouse wheel

Mouse click and drag
Shift + mouse click
Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values
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6.5.9 DL161S — Email Alert

\/ Email Alert [Z| |E|f'5__<|

R ecipient|=] Lizt

Following receipient[z] will receive email alert

johnemitEgrail. com

As DL161S supports real time measurement, therefore, it has an email alert feature, which will
send out an email to the specified user when the device reading is above or below a certain
level. The alert level can be configured in Setting.

User can use this module to select who will receive the email for the specific device.

6.5.10 DL161S — Calibration

DL161S provides an interface to the user for sound level calibration. The calibration
adjustment value is allowed between -12.5 dB and 12.5 dB.

Calibration Adjustment [Z| |E| rg|

Adjustment “alue

2.0 v

(-12.5dE to 12.5dE)

Device connect. [ Ok ] [ Cancel

Enter the value and click “OK” to set the value.
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6.5.11 DL161S — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL161S is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.6 DL141TH2K

DL141TH2K is a data logger for storing light level.

6.6.1 Add new DL141TH2K
When Voltsoft detects a new DL141TH2K attached, the following dialog will be popped up:

Device Management System

Mew device detected, dao wou want ta add it inka the swstem now?

Click “Yes”, the following dialog will be displayed:

Add New Device - ©
Device Series Data Logger W
Model Mumber DL141TH2K W
Alias |
Auto-Detect | | Add Close

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by select Device Management-=Add New Device in menu.

6.6.2 Remove DL141TH2K

To remove DL141TH2K, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.6.3 DL141TH2K—- Device Control Panel

A DL1ATH2K - 141TH2K

. Device  Graph

{ Data \

PC storage range Eariest data:  N/A

Latest data: N/A

Measurement Maximum Value Minimum Value

Average Value

All Data

Export Excel Export CSV

Record Time

The DL141TH2K Device Control Panel contains follow items in menu:

1 Device -> Settings

2 Device -=> Download Data

3 Device -> Display / Plot Data
4 Graph -> Plot Colour

5 Graph -> Background Colour
6 Graph -> Grid

7 Graph -> Line

8 Graph -> Points Indicator

9 Graph -> Print

10 Graph -> Save Image As

11 Graph -= Zoom Out
12 Graph -> Zoom To Fit

This will launch the setting page of DL141TH2K.

Download reading from device.
Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.6.4 DT141TH2K - Settings

12-08-2015 11:50:35 [~

T41THZK

»)

1 Time Configure the device data time value.
The user can specify a defined time or use the system
date time.

2 Logger Name Input the unique alias for that device.

3 Record Start Condition By Button — The data logger will start recording only
after the user pressed the red button on the device.
After Setup — The data logger will start recording
immediately after setup.

4 Sample Points Instruct the logger to take a finite number of readings.

5 Sample Rate Instruct the logger to log readings at a specific rate.

6 Recording Time Calculate the recording time based on the selected
sample points and sample rate.

7 LED Flash Cycle Configure the LED flash cycle - the longer the time, the
longer the battery life.

8 Enable LED Alert Enable / disable LED flash when the alarm is triggered.

9 Low / High Alarm Configure the low / high alarm level.

10 | Default Button Reload the factory default settings.

11 | Setup Button Save changes.

12 | Close Button Close this interface.

Note: Any stored data will be permanently erased when setup is finished.
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6.6.5 DL141TH2K - Download Data

This module allows user to download the data from DL141TH2K.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel ]

Click “OK” button to stop the recording and start downloading.

6.6.6 DL141TH2K- Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

5

Display/Plot Data
() PC storage range

® From:

Measurament

_— )

Eariest data:  15-02-2015 23:15:54 Latest data: 15-02-2015 23:20:48
09-03-201515:18:22 [E~ To: |10-03-201516:18:22 [E~
Temperature “C W

PC Storage Range
Time Range
Measurement

OK

Cancel

Download all data stored in the database.

Select the data reading range.

User can select Celsius or Fahrenheit record to
download.

Click OK to accept the input and display the selected
reading in the data and graph tabs.

Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 will be returned.)
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6.6.7 DL141TH2K — Data View

DL141TH2K contains total four measurements:T1, T2, Temperature and Relative humidity.

" DL141THZK - 141TH2K - X

Device  Graph
/ Data \' Graph \
PC storage range Earliest data:  20-03-2015 19:27:30 Latest data:  20-03-2015 19:30:58
Measurement Maximum Value Minimum Value Average Value
T1(°C) 26.3 246 2575
T2 (*C) 254 253 256.06
Temperature *C 26 26 25.00
Rel Humidity 55.1 54.4
All Data Export Excel Export CSV
Record Time T (°C) T2 (*C) Temperature *C Rel Humidity
20-03-2015 19:27:30 25.0 254 25 547
20-03-21519:27:31 26.0 264 26 548
20-03-201515:27:32 25.0 283 25 5485
20-03-201515:27:33 25.0 283 25 5485
20-03-2015 19:27:34 26.0 26.3 26 545
20-03-2015 15:27:35 25.0 283 25 545
20-03-2015 15:27:36 25.0 283 25 545
20-03-2015 18:27:37 258 283 25 545
20-03-201515:27:38 258 283 25 545
20-03-2015 19:27:39 258 263 26 545
20-03-2015 19:27:40 258 283 25 544
20-03-2015 15:27:41 25.0 283 25 544
20-03-2015 19:27.42 26.0 26.3 26 544
20-03-2015 15:27:43 25.0 283 25 544
20-03-2015 15:27:44 25.0 283 25 544
20-03-2015 15:27:45 25.0 283 25 544
e ans e P ., . - 5
1 Export Excel Export the reading to Excel (.xIs) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.6.8 DL141TH2K- Graph View

_/Im - X
| Device  Graph
I y Graph \
DL141TH2K - 141TH2K
[ x  T1(°Q) % 12(°C) Temperature °C % Rel Humidity |
0o 60
o 551 155
o T T
5507 1 50
g I I
2 a5t Teg
£ I I 2
S 40 4 +40 5
) T 1 T
5 I T -
~ 35 + + 35 é
Ly I I
G 30+ 130
E 25t 125
20 1 : : : | : : : | : : : | : : : | : : : 1 20
19:27:00 19:28:00 19:29:00 19:30:00 19:31:00 19:32:00
20-03-2015 20-03-2015 20-03-2015 20-03-2015 20-03-2015 20-03-2015

Our graph support following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.6.9 DL141TH2K—- Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL141TH2K is the same as Windows version, except the downloaded
data can only have 10,000 readings in a single download.
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6.7 DL181THP

DL181THP is a data logger for storing temperature, humidity and air pressure reading.

6.7.1 Add new DL181THP
When Voltsoft detected a new DL181THP attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want ko add it into the swskerm now?

Click “Yes”, the following dialog will be displayed:

\/ add Hew Device

Device Series |Data Loager

model Mumber |DL1E1THP

Alias 181THA

[.ﬁ.utD-Detect ] [ Add l [

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management-=>Add New Device in menu.

6.7.2 Remove DL181THP

To remove DL181THP, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.7.3 DL181THP — Device Control Panel
DL181THP - 181THP l - M
Device  Graph
,'/ Data \ Graph §
PC storage range Earliest data:  27-01-2013 22:11:45 Latest data:  27-01-2013 22:20:45
¥ Sumrnary
All Data I Export Excel I [ Expart C5Y l
Recaord Time Temperature (*C) Felative Hurmidity (%) Air Prezsure (hPa)
27-01-2013 2211:45 236 265 596.05
27-01-2013 2212:45 234 533 89565
27-01-2013 221345 241 521 89525
27-01-2013 221445 242 52389 895135
27-01-2013 221545 242 a7 89515
27-01-2013 2216:45 242 514 895.05
27012013 221745 242 512 894 B5
27-01-2013 2218:45 242 a1.2 894 .85
27-01-2013 2219:45 242 1.4 594 .95
2T-01-2013 22 20:45 2473 534 894 .85

The DL181THP Device Control Panel contains the following items in menu:

1
2
3

10
11
12

Device -> Settings

Device -=> Download Data
Device -> Display / Plot Data
Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As

Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of DL181THP.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.7.4 DL181THP — Settings

\/181THP: - Settings (HW ID:0004_12101700002)

Basic Settings

Tirne Use System Time
Logger Mame 181THP

Record Start Condition (O By Buttan ) After Setup

Sample Rate 0 % Hours) 1 % Minute(s)

Sarmple Points 10000 5

Recording Time 6 Days 22 Hours 40 Minutes

Enable LEDs Record 105 Secis)
Alarm Settings
Enable LEDs Alert 1 % Sec(s)
Temperature Low Level 400 D) e High Level /00 2 oG
Hurmidity Lowe Level 0.0 =1 High Level mo 2 %
Air Pressure Loy Level 7000 20 hPa  High Level 11000 3| hPa
Device connect.
[ Default l [ Setup l [ Close

1 Time

2 Logger Name
3 Record Start Condition

4 Sample Rate

5 Sample Points
6 Recording Time

7 Altitude
8 Record LED Flash

9 Enable LED Alert

10 Temperature Low / High
Alarm

11 Humidity Low / High Alarm

12 | Air Pressure Low / High
Alarm

13 Default Button

14  Setup Button

15 | Close Button

Configure the device data time value.

The user can specify a defined time or use the system

date time.

Input the unique alias for that device.

By Button — The data logger will start recording only
after the user presses the red button on
the device.

After Setup — The data logger will start recording
immediately after setup.

Instruct the data logger to log readings at a specific

rate.

Configure the data logger sample points.

Calculate the recording time based on the selected

sample points and sample rate.

Allows user to set the current altitude.

Configure the LED flash cycle - the longer the time, the

longer the battery life.

Enable / disable LED flash when the alarm is triggered.

Configure the temperature low / high alarm level

Configure the humidity low / high alarm level
Configure the air pressure low / high alarm level

Load the factory default settings.

Save changes.
Close this interface.
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6.7.5 DL181THP - Download Data

This module allows user to download the data from DL181THP.

Download Data Q@@

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.7.6 DL181THP — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplap/Plot D ata

() PC storage range Earliest data: M4 Latest data; MAS

) From: 03-12-2012 16:22:34 hd To: (10122012 17.22.34 hd

Device connect.

[ ok | [ Cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.7.7 DL181THP — Data View

DL181THP contains three measurements (Temperature, relative humidity and pressure),
template unit can be Celsius or Fahrenheit and pressure unit can be hPa / kPa / Bar / SPI,
depending on the setting in general setting.

DL181THP - 181THP l - X

Device  Graph

,'/ Data \ Graph ll"'.

PC storage range Earliest data:  27-01-2013 22:11:45 Latest data:  27-01-2013 22:20:45
¥ Sumrnary |
All Data I Export Excel I [ Expart C5Y l
Recaord Time Temperature (*C) Felative Hurmidity (%) Air Prezsure (hPa)
27-01-2013 22:11:45 236 265 596.05
27-01-2013 22:12:45 2349 533 595.65
27-01-2013 22:13:45 241 521 59525
27-01-2013 221445 242 534 893,15
27-01-2013 22:19:45 242 a7 89315
27-01-2013 22:16:45 242 514 595.05
27-01-2013 2217:45 242 512 594 65
27-01-2013 22:18:45 242 212 594.85
27-01-2013 22:19:45 242 214 594.95
27-01-2013 22:20:45 243 534 594 .85
1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.7.8 DL181THP — Graph View

DL181THP - 181THP l - X

Device  Graph

Data / Graph \

DL181THP - 181THP
[ = Temperature Retative Humidiy . Air Preszure |

G0 T T 8962
- % —+ 896.0
<
£ . 18358
E ]
=z + 8956 =
g
B 1 18954 @
e 40 + 7
- 1 I -
g 95,2 &
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E + 8950 <
= 1
@ 30 +
E— 1 T 894.8
& _
. + 8946

e :
20 + + + + } + + + + } + i 894 4
22:10:00 22:15:00 22:20:00
27-01-2013 27-01-2013 27-01-2013

Our graph support following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values
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6.7.9 DL181THP — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL181THP is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.8 DL131LUX

DL131LUX is a data logger for storing light level.

6.8.1 Add new DL131LUX
When Voltsoft detects a new DL131LUX attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it inko the system now?

Click “Yes”, the following dialog will be displayed:

Add New Device - ©
Device Series Data Logger W
Maodel Mumber DL13TLL W
Alias
Auto-Detect Add Close

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.8.2 Remove DL131LUX

To remove DL131LUX, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.8.3 DL131LUX — Device Control Panel

Device

Graph

DL131LUX - 131LUX

PC storage range

e \

& Summary

Earliest data:  14-D6-2015 14:28:07 Latest data

14-06-2015 14:39.07

Solar

Measurement

Maximum Value Hinimum Value

Average Value

All Data

Export Excel Export C5V

Record Time Solar

The DL131LUX Device Control Panel contains follow items in menu:

1
2
3

10
11
12

Device -> Settings

Device -=> Download Data
Device -> Display / Plot Data
Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As

Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of DL131LUX.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.8.4 DL131LUX - Settings

12-08-2015 11:59:33  [~-

1 Time Configure the device data time value.
The user can specify a defined time or use the system
date time.

2 Logger Name Input the unique alias for that device.

3 Record Start Condition By Button — The data logger will start recording only
after the user pressed the red button on the device.
After Setup — The data logger will start recording
immediately after setup.

4 Sample Points Instruct the logger to take a finite number of readings.

5 Sample Rate Instruct the logger to log readings at a specific rate.

6 Recording Time Calculate the recording time based on the selected
sample points and sample rate.

7 LED Flash Cycle Configure the LED flash cycle - the longer the time, the
longer the battery life.

8 Enable LED Alert Enable / disable LED flash when the alarm is triggered.

9 Low / High Alarm Configure the low / high alarm level.

10 | Default Button Reload the factory default settings.

11 Setup Button Save changes.

12 | Close Button Close this interface.

Note: Any stored data will be permanently erased when setup is finished.
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6.8.5 DL131LUX - Download Data

This module allows user to download the data from DL131LUX.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.8.6 DL131LUX — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplap/Plot D ata

() PC storage range Earliest data: M4 Latest data; MAS

) From: 03-12-2012 16:22:34 hd To: (10122012 17.22.34 hd

Device connect.

[ ok | [ Cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 will be returned.)
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6.8.7 DL131LUX — Data View

DL131LUX contains one measurement only, the light level.

A DL131LUX - 131LUX - X

Device  Graph

[ o \ \

PC storage range Eariest data:  14-06-2015 14:28:07 Latest data:  14-06-2015 14:39:07

Measurement Maximum Value Minimum Value Average Value

Solar 0 0 0.00

All Data Export Excel Export CSV

Record Time Solar

14-06-2015 14:28:07
14-08-2015 14:28:07
14-08-2015 14:30:07
14-08-2015 14:31:07
14-08-2015 14:32:07
14-08-2015 14:33:07
14-06-2015 14:34:07
14-08-2015 14:35:07
14-08-2015 14:36:07
14-06-2015 14:37:07
14-06-2015 14:38:07
14-08-2015 14:38:07

o 00 o0 o0 o0 oo o000

1 Export Excel Export the reading to Excel (.xlIs) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.8.8 DL131LUX — Graph View

A DL131LUX - 131LUX

Graph

Device

Graph \

Solar

ES olar

DL131LUX - 131LUX

08 L
06 L
04 1

02 +

0.0

T
14:35:05
14-06-2015

" ; ;
14:35:06 14:35:07
14-06-2015 14-06-2015
Time: 14-06-2015 14:35:07 Solar:0

Our graph support following operations

1

2
3
4

Mouse wheel

Mouse click and drag
Shift + mouse click
Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values

6.8.9 DL131LUX — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL131LUX is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.9 DL161SAN

DL161SAN is a data logger for storing wind speed.

6.9.1 Add new DL161SAN
When Voltsoft detects a new DL161SAN attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it inko the system now?

Click “Yes”, the following dialog will be displayed:

Add New Device - ©
Device Series Data Logger W
Maodel Mumber DL161SAMN W
Alias
Auto-Detect Add Close

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.9.2 Remove DL161SAN

To remove DL161SAN, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.9.3 DL161SAN — Device Control Panel

" DL161SAN - 1615AN

. Device  Graph

f Data

FC storage range

Earliest data:

N/A

Latest data:  N/A

Measurement Maximum Value
Maximum Value

Average Value

Minimum Valug

RT Value

Winimum Value

Average Value

All Data

Export Excel Export CSV

Record Time Maximum Value

Average Value

Winimum Value RT Value

The DL161SAN Device Control Panel contains follow items in menu:

1 Device -> Settings

2 Device -> Download Data
3 Device -> Display / Plot Data

4 Graph -> Plot Colour

5 Graph -> Background Colour

6 Graph -> Grid

7 Graph -> Line

8 Graph -> Points Indicator

9 Graph -> Print

10 Graph -> Save Image As

11
12

Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of DL161SAN.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.

Zoom out one level.
Undo all zoom in and out.

89



Voltsoft User Manual

Version 2.5

6.9.4 DL161SAN - Settings

13-08-2015 14:41:37 [~

615AM

416 Days 16 Hours

») [ ] ®

1 Time Configure the device data time value.
The user can specify a defined time or use the system
date time.

2 Logger Name Input the unique alias for that device.

3 Record Start Condition By Button — The data logger will start recording only
after the user pressed the red button on the device.
After Setup — The data logger will start recording
immediately after setup.

4 Sample Points Instruct the logger to take a finite number of readings.

5 Sample Rate Instruct the logger to log readings at a specific rate.

6 Recording Time Calculate the recording time based on the selected
sample points and sample rate.

7 LED Flash Cycle Configure the LED flash cycle - the longer the time, the
longer the battery life.

8 Enable LED Alert Enable / disable LED flash when the alarm is triggered.

9 Low / High Alarm Configure the low / high alarm level.

10 | Default Button Reload the factory default settings.

11 | Setup Button Save changes.

12 | Close Button Close this interface.

Note: Any stored data will be permanently erased when setup is finished.
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6.9.5 DL161SAN - Download Data

This module allows user to download the data from DL161SAN.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

*You must place the datalogger on the key lock before download data.

6.9.6 DL161SAN — Display / Plot Data

This module allows user to select a range for the device readings from the device and display

them in the data tab and graph tab.

Display/Plot Data

[hzplay/Plot D ata

() PC storage range Earliest data: M4 Latest data: MA4

Device connect.

&) From: 03-12-2012 16:22:34 ¥ Ta: [1012-2012 17:22:34 ¥

[ o || cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected

reading in the data and graph tabs.

4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web

version, only the first 10,000 will be returned.)
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6.9.7 DL161SAN — Data View

DL161SAN contains four measurement: Maximum Value, Average Value, Minimum Value and
RT Value.

-~ DL1615AN - 161SAN - X

Device  Graph
: Data Graph ‘\\
PC storage range Earliest data:  15-02-2015 21:49.22 Latest data:  15-02-2015 21:52:22
¥ Summary
All Data Export Excel Export CSV
Record Time Maximum Value Average Value Minimum Walue RT Value
15-02-2015 21:45:22 1.54 0.64 0 1.94
15-02-2015 21:49:25 4592 293 1.54 492
15-02-2015 21:45:28 914 8.82 85 914
15-02-2015 21:45:31 2069 16.83 914 20.69
15-02-2015 21:45:34 2069 2065 2085 20.69
15-02-2015 21:45:37 2069 14.93 3.43 3.43
15-02-2015 21:49:40 432 432 343 482
15-02-2015 21:45:43 17.63 13.35 482 17.63
15-02-2015 21:45:45 17.63 M.75 0 0
15-02-2015 21:49:45 0 0 0 0
15-02-2015 21:45:52 0 0 0 0
15-02-2015 21:45:55 0 0 0 0
15-02-2015 21:45:58 0 0 0 0
15-02-2015 21:50:01 0 0 0 0
15-02-2015 21:50:04 2.85 529 0 285
15-02-2015 21:50:07 1472 1278 8.85 14.72
15-02-2015 21:50:10 1472 1472 1472 14.72
15-02-2015 21:50:13 1472 7.89 408 487
15-02-2015 21:50:16 487 487 487 487
15-02-2015 21:50:19 13.42 13.42 13.42 13.42
15-02-2015 21:50:22 13.42 13.42 13.42 13.42
15-02-2015 21:50:25 40 40 40 40
15-02-2015 21:50:28 40 13.33 0 0
15-02-2015 21:50:31 0 0 0 0
15-02-2015 21:50:34 0 0 0 0
1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.9.8 DL161SAN — Graph View
" DL161SAN - 1615AN - X
. Device  Graph
/ / Graph \
DL161SAN - 161SAN
[ Maximum Value Average Value *  Minimum Value RT Value
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Our graph support following operations

1

2
3
4

Mouse wheel

Mouse click and drag
Shift + mouse click
Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values

6.9.9 DL161SAN — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL161SAN is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.10 DL201THM

DL201THM is a data logger for storing moisture.

6.10.1 Add new DL201THM
When Voltsoft detects a new DL201THM attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it inko the system now?

Click “Yes”, the following dialog will be displayed:

Add New Device - ©
Device Series Data Logger W
Maodel Mumber DL THM W
Alias
Auto-Detect Add Close

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.10.2 Remove DL201THM

To remove DL201THM, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.10.3 DL201THM — Device Control Panel

" DL201THM - 201THM

Device  Graph

{ Data \

PC storage range Earliest data: MN/A

Latest data:  N/A

Measurement Maximum Walug Winimum Value

Average Value

All Data

Export Bxcel Export CSV

Record Time

The DL201THM Device Control Panel contains follow items in menu:

1 Device -> Settings

2 Device -=> Download Data

3 Device -> Display / Plot Data
4 Graph -> Plot Colour

5 Graph -> Background Colour
6 Graph -> Grid

7 Graph -> Line

8 Graph -> Points Indicator

9 Graph -> Print

10 Graph -> Save Image As

11 Graph -=> Zoom Out
12 Graph -> Zoom To Fit

This will launch the setting page of DL201THM.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.10.4

DL201THM - Settings

13-08-2015 14:57:25 [~

1 Time Configure the device data time value.
The user can specify a defined time or use the system
date time.

2 Logger Name Input the unique alias for that device.

3 Record Start Condition By Button — The data logger will start recording only
after the user pressed the red button on the device.
After Setup — The data logger will start recording
immediately after setup.

4 Sample Points Instruct the logger to take a finite number of readings.

5 Sample Rate Instruct the logger to log readings at a specific rate.

6 Recording Time Calculate the recording time based on the selected
sample points and sample rate.

7 LED Flash Cycle Configure the LED flash cycle - the longer the time, the
longer the battery life.

8 Enable LED Alert Enable / disable LED flash when the alarm is triggered.

9 Low / High Alarm Configure the low / high alarm level for different
measurement.

10 | Default Button Reload the factory default settings.

11 Setup Button Save changes.

12 | Close Button Close this interface.

Note: Any stored data will be permanently erased when setup is finished.
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6.10.5

DL201THM - Download Data

This module allows user to download the data from DL201THM.

Download Data

Click “OK” button to stop the recording and start downloading.

6.10.6

DL201THM — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

05-03-2015 15:0043 [El~ 10:03-2015 16:00.43  [El~

1 PC Storage Range Download all data stored in the database.

2 Time Range Select the data reading range.

3 Measurement User can select Celsius or Fahrenheit record to
download.

4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 will be returned.)
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6.10.7 DL201THM — Data View

DL201THM contains three measurements: Wood humidity, Temperature, Relative humidity.

~ DLZO1THM - 201THM - X

Device  Graph
/ Data \ Graph \
PC storage range Eariest data: 26-06-2014 14:37:43 Latest data:  26-06-2014 14:41:43
A} Summary
Measurement Maximum Value Minimum Value Average Value
Wood Humidity o o 0.00
Temperature *C (°C} 273 273 27.40
Rel Humidity 55.1 551 5573
All Data Export Bxcel Export CSV
Record Time Wood Humidity Temperature °C (°C} Rel Humidity
25-06-2014 14:37:43 0 274 56.3
25-06-2014 14:35:43 0 275 55.1
25-06-2014 14:41:43 0 273 558
1 Export Excel Export the reading to Excel (.xlIs) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.10.8 DL201THM — Graph View
" DL201THM - 201THM - X
.. Device  Graph
) / Graph \
DL201THM - 201THM
[ x Wood Humidity Temperature 'C w  Rel Humidity |
27288 —m™—7F 47— —  ————————F————7————7 10
i b =
27.50 —Z T 60 =
I I £
F T 50 5
© 2745 % - =
o I 1 I
S T T 40 E
T 2740 £ I >
e T +30%
£ 1 T £
27.35 + I
= 3 120
I I B
27.30 + I b
3 17102
27.25 F— e e - —f—t+——+—+— bt —t L 0
14:37:00 14:38:00 14:39:00 14:40:00 14:41:00 14:42:00 14:43:00
26-06-2014 26-06-2014 26-06-2014 26-06-2014 26-06-2014 26-06-2014 26-06-2014
Time: 26-06-2014 14:39:43 Wood Humidity:0 Temperature "C:27.5 Rel Humidity:55.1

Our graph support following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values
6.10.9 DL201THM — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL201THM is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.11 DL111K

DL111K is a data logger for storing temperature reading.

6.11.1 Add new DL111K
When Voltsoft detected a new DL111K attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want ko add it into the swskerm now?

Click “Yes”, the following dialog will be displayed:

\/ Add Hew Device

Device Series |Data Loager v|
Model Mumber | DL111K v|
Alias 111K |

[.ﬁ.utD-Detect ] [ Add l [ Cloze ]

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management-=>Add New Device in menu.

6.11.2 Remove DL111K

To remove DL111K, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device want to remove and click the “Remove” button.
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6.11.3 DL111K — Device Control Panel
" DLIT1K - 111K - X
Device  Graph
X Data \ Graph "'.\
PC storage range Earliest data; M2, Latest data; WA
2 Summary
eazurement Maximum Yalue Minimum “alue Average Value
All Data Expart Excel l [ Export C5W
Record Tine Temperature 52

The DL111K Device Control Panel contains the following items in menu:

1 Device -> Settings

2 Device -> Download Data

3 Device -> Display / Plot Data
4 Graph -> Plot Colour

5 Graph -> Background Colour
6 Graph -> Grid

7 Graph -> Line

8 Graph -> Points Indicator

9 Graph -> Print

10 Graph -> Save Image As

11 Graph -> Zoom Out
12  Graph -= Zoom To Fit

This will launch the setting page of DL111K.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.11.4

10
11
12

/111K - Settings (HW ID:0017_07030100001)

DL111K — Settings

Basic Settings

Tirme

Logger Marme

Fecord Start Condition
Delay Time

sarnple Hate

LED Flash Cycle

Alarm Settings
LInit

Lo Level

Device connect.

Use System Time
() By Buttan (3 After Setup
0 Sec b
1 > | |Second b
) 10s O 20s (305 (&) No Light
Temperature "C w
-200 - High Level 1370 -
Default ] [ Setup l [ Cancel

Time

Logger Name
Record Start Condition

Delay Time

Sample Rate
LED Flash Cycle

Unit

Temperature Low / High
Alarm

Default Button

Setup Button

Close Button

Configure the device data time value.

The user can specify a defined time or use the system

date time.

Input the unique alias for that device.

By Button — The data logger will start recording only
after the user pressed the red button on
the device.

After Setup — The data logger will start recording
immediately after setup.

Only available if “After Setup” selected.

Specify the delay time for recording start after setup.
Instruct the logger to log readings at a specific rate.
Configure the LED flash cycle - the longer the time, the
longer the battery life.

Select temperature unit (Celsius or Fahrenheit)
Configure the temperature low / high alarm level.

Reload the factory default settings.

Save changes.
Close this interface.
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6.11.5

DL111K -

Download Data

This module allows user to download the data from DL111K.

Download Data Q@@

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.11.6

DL111K - Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display f Plot Data

EEX

Dizplay ¢ Plot Drata

) PC Storage Fange

+) Fram:

Measurement

Earliest data;  05-02-2013 18:24:04 Latest data; 05-02-2013 18:35:29

| 04-02-2013 18:56:039 w To: | 05-02-2013 193:56:03 b

| Temperature °C w |

| o || oclose

5

PC Storage Range
Time Range
Measurement

OK

Cancel

Download all data stored in the database.

Select the data reading range.

User can select Celsius or Fahrenheit record to
download.

Click OK to accept the input and display the selected
reading in the data and graph tabs.

Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.11.7 DL111K — Data View

DL111K contains one measurement (Temperature) only, its unit can be Celsius or Fahrenheit,
and can be selected in Display / Plot Data dialog.

< DL111K - 111K - X

Device  Graph

Data \ Graph

PC ztorage range Earliest data: 06-02-2013 16:20:24 Latest data:  07-02-2013 01:10:31

¥ Summary
All Data Export Excel l [ Expart CSY l
Recard Time Temperature 52 o
06-02-2013 16:20:40 252

06-02-2013 16:20:41 252

06-02-2013 16:20:42 251

06-02-2013 16:20:43 250

06-02-2013 16:20:44 250

06-02-2013 1620045 252

06-02-2013 1620046 251

05-02-2013 16:20:47 22

05-02-2013 1620045 252

05-02-2013 16:20:49 244

06-02-2013 16:20:50 250

06-02-2013 16:20:51 250

06-02-2013 16:20:52 250

06-02-2013 16:20:53 250

06-02-2013 16:20:54 250

06-02-2013 16:20:55 249

06-02-2013 16:20:56 251

06-02-2013 1620057 252

06-02-2013 1620055 252

05-02-2013 16:20:59 231

05-02-2013 16:21:00 251

05-02-2013 16:21:01 232

06-02-2013 16:21:02 252

06-02-2013 16:21:03 252

06-02-2013 16:21:04 251

06-02-2013 16:21:05 251

06-02-2013 16:21:06 252

06-02-2013 16:21:07 251 .

1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.11.8 DL111K — Graph View

< DL111K - 111K - X

Device  Graph

I-"I Data I/ Graph \

DL1M11K - 111K

[ % Temperature "C ]
255 —

254 L
253 +
252 +

251 1

Temperature °C

250

249 I

248 | . : . | . . : | : . . | .
16:20:00 16:22:00 16:24:00 16:26:00
06-02-2013 06-02-2013 06-02-2013 06-02-2013

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values
6.11.9 DL111K — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL111K is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.12 DL191A

DL191A is a data logger for measuring current.

6.12.1 Add new DL191A
When Voltsoft detected a new DL191A attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want ko add it into the swskerm now?

Click “Yes”, the following dialog will be displayed:

\/ Add New Device

Device Series |Data Logger

Model Number | DL1914

Alias 1914

[.ﬁ.utD-Detect ] [ Add l [

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.12.2 Remove DL191A

To remove DL191A, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.12.3 DL191A - Device Control Panel
Device  Graph
f Data \' Graph I"\
PC storage range Earliest data:  29-03-2013 17:32:30 Latest data:  29-03-2013 17:32:52
2 Summary
Measurement Maximum Yalue Minimum % alue Average Value
Current (ma 0.02 0.02 002
All Data Expart Excel ] [ Export 5y
Record Time Current (m)

29-03-201317:32:30
20-03-20M3173232
29-03-20M317:32:34
29-03-201317:32:36
29-03-2M317.32:38
29-03-201317:32:40
28-03-213 1732042
29-03-2M317.32:44
29-03-201317:32:46
20-03-20M3 1732048
29-03-20M317:32:50
29-03-201317:32:52

o0z
ooz
o0z
o0z
ooz
o0z
ooz
ooz
o0z
ooz
o0z
o0z

The DL191A Device Control Panel contains the following items in menu:

1 Device -> Settings
2 Device -> Download Data
3 Device -> Display / Plot Data

4 Graph -> Plot Colour

5 Graph -> Background Colour

6 Graph -> Grid

7 Graph -> Line

8 Graph -> Points Indicator

9 Graph -> Print

10
11
12

Graph -> Save Image As
Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of DL191A.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.12.4 DL191A — Settings

\/ 1914 - Settings (HW ID:0014_12090600001)

Basic Settings

Time Use System Time
Logger Marne 1914

Record Start Condition ) By Button (¥ After Setup

mample Points 32000 w

sample Rate 2s v

Record LED Flash ® 10s O 20s () 30s

Alarrm Settings
Enable LED Alert

Low Level f ¥ High Lewvel 20 s
Device connect.
Drefault ] [ Setup ] [ Cloze
1 Time Configure the device data time value.
The user can specify a defined time or use the system
date time.
2 Logger Name Input the unique alias for that device.
3 Record Start Condition By Button — The data logger will start recording only
after the user pressed the red button on
the device.

After Setup — The data logger will start recording
immediately after setup.

4 Sample Points Configure the data logger sample points.

5 Sample Rate Instruct the data logger to log readings at a specific
rate.

6 Record LED Flash Configure the LED flash cycle - the longer the time, the
longer the battery life.

7 Enable LED Alert Enable / disable LED flash when the alarm is triggered.

8 Low / High Alarm Configure the low / high alarm level for current.

9 Default Button Load the factory default settings.

10 Setup Button Save changes.

11 Close Button Close this interface.
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6.12.5 DL191A - Download Data

This module allows user to download the data from DL191A.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.12.6 DL191A - Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplap/Plot D ata

() PC storage range Earliest data: M4 Latest data; MAS

) From: 03-12-2012 16:22:34 hd To: (10122012 17.22.34 hd

Device connect.

[ ok | [ Cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click on OK to accept the input and display the selected
reading in the data and graph tabs.

4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.12.7 DL191A - Data View
DL191A contains one measurement (current) only.

- X

~ DL191A - 1914

Device  @raph

FC ztorage range

¥ Surmary

Graph "'.‘

Earliest data:  29-03-2013 17:32:30 Latest data;  29-03-2013 17:32:52

All Data

Recard Time
29-03-2013 173230
29-03-2013 173232
29-03-2013 173234
29-03-2013 173236
29-03-2013 173238
29-03-2013 173240
29-03-2013 173242
29-03-20M13 173244
29-03-2013 173246
29-03-20M13 173245
29-03-2013 173250
29-03-2013 173252

1

Export Excel
Export CSV

Current (ma)

0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z
0.0z

Export Excel

I

Export C5Y ]

Export the reading to Excel (.xls) format.
Export the reading to Excel (.csv) format.
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6.12.8 DL191A — Graph View
__/[m - X

| Device Graph
Data / Graph \

DL191A - 191A

[ > Current(m#) |
0.0210 ————————————

0.0205 1

0.0200 1

Current (mA)

0.0195 1

0.0190 | —t—+—+—+—+—t—+—+—+—+—
17:32:2 17:32:32 17:32:37 17:32:42 17:32:47 17:32:52
29-03-2013 29-03-2013 29-03-2013 29-03-2013 29-03-2013 29-03-2013

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values
6.12.9 DL191A — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL191A is the same as Windows version, except the download data can
only have 10,000 readings in a single download.
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6.13 DL191V

DL191V is a data logger for measuring voltage.

6.13.1 Add new DL191V
When Voltsoft detected a new DL191V attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want ko add it into the swskerm now?

Click “Yes”, the following dialog will be displayed:

'/ Add New Device M=

Device Series |Data Loager v|
Model Number  DL19TY v/
Alias 11914 |

[.ﬁ.utD-Detect ] [ Add l [ Cloze ]

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management-=>Add New Device in menu.

6.13.2 Remove DL191V

To remove DL191V, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.13.3 DL191V — Device Control Panel
A DL191Y - 191 - X

Device

Graph

/

Data \

PC storage range

Graph "'.\

Earliest data: 18-03-201312:18:M

Latest data: 18-03-20131219:20

¥ Summary

All Data Export Excel ] [ Expart CS5Y ]
Record Time Woltage (V) ~
18-03-2013 12:18:01 .0000 111

158-03-2013 1218:01 0025 1.1

18-03-2013 12:18:01 0050 110

158-03-2013 1218:01 0075 1.10

18-03-201312:18:01 0100 110

158-03-2013 121801 0125 1.10

18-03-20131218:01 0150 110

18-03-201 3121801 0175 110

158-03-2013 1218:01 .0200 1.10

18-03-20131218:01 0225 110

158-03-2013 1218:01 0250 1.09

18-03-20131218:01 0275 110

158-03-2013 1218:01 0300 1.09

18-03-2013 1218:01 0325 1.08

158-03-2013 1218:01 0350 1.09

18-03-20131218:01 0375 110

158-03-2013 1218:01 .0400 1.09

18-03-2013 12:18:01 0425 110

18-03-2013 1218:01 0430 110

158-03-2013 1218:01 0475 1.10

18-03-2013 12:18:04 0500 110

158-03-2013 1218:01 0525 1.1

18-03-2013 12:18:01 0550 110

18-03-2013 1218:01 0575 1.1

18-03-2013 12:18:01 0600 110

158-03-2013 1218:01 0625 1.10

18-03-2013 12:18:01 0650 111 3

19 M2 N1 24-12-M1 NETE

44N

The DL191V Device Control Panel contains the following items in menu:

Device -> Download Data
Device -> Display / Plot Data

Graph -> Background Colour

Graph -> Points Indicator

Graph -> Save Image As

1 Device -> Settings
2

3

4 Graph -> Plot Colour
5

6 Graph -> Grid

7 Graph -> Line

8

9 Graph -> Print

10

11 Graph -=> Zoom Out
12

Graph -> Zoom To Fit

This will launch the setting page of DL191V.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.13.4 DL191V - Settings
\/ 191V - Settings (HW ID:0013_12080700003)

Basic Settings

Tirme Lise System Time
Logger Mame 1914

Record Start Condition ) By Button () After Setup

Sample Paints 32000 w

Sample Rate 25 w

LED Flash Cycle ) 10s O 20s ) 30s

Alarm Settings

Enable LED Alert

Lowe Level 0 - High Level 20 %
Device connect.

[ Default l [ Setup l ’ Cloze

1 Time Configure the device data time value.

The user can specify a defined time or use the system
date time.

2 Logger Name Input the unique alias for that device.

3 Record Start Condition By Button — The data logger will start recording only
after the user pressed the red button on
the device.

After Setup — The data logger will start recording
immediately after setup.

4 Sample Points Configure the data logger sample points.

5 Sample Rate Instruct the data logger to log readings at a specific

rate.

6 Record LED Flash Configure the LED flash cycle - the longer the time, the

longer the battery life.

7 Enable LED Alert Enable / disable LED flash when the alarm is triggered.

8 Low / High Alarm Configure the low / high alarm level for voltage.

9 Default Button Load the factory default settings.

10 Setup Button Save changes.

11 Close Button Close this interface.
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6.13.5 DL191V - Download Data

This module allows user to download the data from DL191V.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.13.6 DL191V — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplap/Plot D ata

() PC storage range Earliest data: M4 Latest data; MAS

) From: 03-12-2012 16:22:34 hd To: (10122012 17.22.34 hd

Device connect.

[ ok | [ Cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.13.7 DL191V — Data View
DL191V contains one measurement (voltage) only.

< DL191Y - 191 - X

Device  @raph

(i Data

PC storage range

Earliest data:

Graph "'.\

18-03-201312:18:M Latest data:  18-03-201312:19:20

¥ Summary
All Data Expart Excel ] [ Expart C5Y l
Recaord Time Woltage (V) ~
158-03-2013 1218:01 .0000 1.1
18-03-2013 12:18:01 0025 111
18-03-2013 12:18:01 0050 110
158-03-2013 1218:01 0075 1.10
18-03-201312:18:01 0100 110
158-03-2013 121801 0125 1.10
18-03-20131218:01 0150 110
158-03-2013 12180 0175 1.10
18-03-2013 12:18:01 0200 110
158-03-2013 1218:01 0225 1.10
18-03-2013 12:18:01 0250 1.08
158-03-2013 1218:01 0275 1.10
18-03-2013 12:18:01 0300 1.08
18-03-2013 1218:01 0325 1.08
158-03-2013 1218:01 0350 1.09
18-03-20131218:01 0375 110
158-03-2013 1218:01 .0400 1.09
18-03-2013 12:18:01 0425 110
158-03-2013 1218:01 0450 1.10
18-03-20131218:01 0475 110
158-03-2013 1218:01 0200 1.10
18-03-2013 12:18:01 0525 111
158-03-2013 1218:01 0550 1.10
18-03-20131218:01 0575 111
18-03-2013 12:18:01 0600 110
158-03-2013 1218:01 0625 1.10
18-03-2013 12:18:01 0650 111 3
A2 N2 24120 NETE 11N

1 Export Excel

2 Export CSV

Export the reading to Excel (.xls) format.
Export the reading to Excel (.csv) format.
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6.13.8 DL191V — Graph View

< DL191¥ - 191¥ - X

Device  Graph
Data I/ Graph \

DL191V - 191V

14 — .

T
ol M % OB

0.8

Voltage

06 |

04 +

02 |

0.0 + - ; . .
12:17:53.0000 12:18:23.0000 12:18:53.0000 12:19:23.0000
18-03-2013 18-03-2013 18-03-2013 18-03-2013

Time: 18-03-2013 12:18:30 Voltage:0.003

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values
6.13.9 DL191V — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL191V is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.14 DL151AN

DL151AN is a data logger for measuring air velocity.

6.14.1 Add new DL151AN
When Voltsoft detected a new DL151AN attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want ko add it into the swskerm now?

Click “Yes”, the following dialog will be displayed:

\/ #dd New Device

Device Series |Data Looger v|
Model Number | DLISTAN v/
Alias 514N |

[.-’-‘-.utu:u-Detect ] [ Add ] [ Close ]

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.14.2 Remove DL151AN

To remove DL151AN, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.14.3 DL151AN — Device Control Panel

- DL151AN-151 -

Device  araph
x Data \ Graph

.IlI

PC storage range Earliest data:  23-03-2013 21:32:22 Latest data:  23-03-2013 21:40:03

¥ Summary

All Data Expart Excel l [ E=port C5Y
Record Time Unit(mis)
28-03-201 3 21:356:22 0.00
28-03-2013 21:35:24 3.92
28-03-20M3 21:38:26 341
28-03-2013 21:38:28 4581
28-03-2013 21:38:30 214
28-03-2013 21:38:32 545
28-03-2013 21:38:54 4 52
28-03-201 3 21:38:36 1.89
28-03-201 3 21:38:38 £.09
28-03-201 3 21:358:40 1.76
28-03-201 3 21:358:42 240
28-03-201 3 21:358:44 1149
28-03-201 3 21:38:46 1.20
28-03-201 3 21:38:45 2M
28-03-201 3 21:38:50 1.08
28-03-201 3 21:38:52 0.a0
28-03-201 3 21:38:54 360
28-03-201 3 21:358:56 1.38
28-03-201 3 21:35:55 1.60
28-03-201 3 21:35:00 3.35
28-03-201 3 21:35:02 449
28-03-201 3 21:35:04 1.83
28-03-2013 21:39:41 0.00
28-03-201 3 21:39:43 0.00
28-03-201 3 21:39:45 0.00
28-03-201 3 21:39:47 4 68
28-03-2013 21:39:49 4 B3
20390 3 71-90-51 151

The DL151AN Device Control Panel contains the following items in menu:

1 Device -> Settings
2 Device -> Download Data
3 Device -> Display / Plot Data

This will launch the setting page of DL151AN.
Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change
the colour of the individual lines.

4 Graph -> Plot Colour

10
11
12

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As

Graph -> Zoom Out
Graph -> Zoom To Fit

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.14.4 DL151AN — Settings
\/ 151 - Settings (HW ID:0011_12101000002)

Basic Settings

Time Use System Time
Logger Marme 161

Record Stat Condition ) By Button () After Setup

=ample Points 32000 w

mample Rate 23 w

LED Flash Cycle () 10s ) 20s () 30s

Alarm Settings

Enable LED Alert

Low Level |0 % High Level 15 & Unit |mfs W
Device connect,

Drefault ] [ Setup ] [ Cloze

1 Time Configure the device data time value.

The user can specify a defined time or use the system
date time.

2 Logger Name Input the unique alias for that device.

3 Record Start Condition By Button — The data logger will start recording only
after the user presses the red button on
the device.

After Setup — The data logger will start recording
immediately after setup.

4 Sample Points Configure the data logger sample points.

5 Sample Rate Instruct the data logger to log readings at a specific

rate.

6 Record LED Flash Configure the LED flash cycle - the longer the time, the

longer the battery life.

7 Enable LED Alert Enable / disable LED flash when the alarm is triggered.

8 Low / High Alarm Configure the low / high alarm level for air velocity.

9 Default Button Load the factory default settings.

10 Setup Button Save changes.

11 Close Button Close this interface.
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6.14.5 DL151AN - Download Data

This module allows user to download the data from DL151AN.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.14.6 DL151AN — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display / Plot Data g|§|@

Dizplay £ Flat Data
() PC Storage Range Earliest data;  29-03-2013 21:38:22 Latest data; 29-03-2013 21:40:03
) From: |28-I33-2EI13 22:0313 hd T |29-EIB-2IZI13 230313 hd
Measurernent |L|nit[m.-"s] v|
| ok || Close
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 Measurement User can select which measurement unit to download.
4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.14.7 DL151AN - Data View

DL151AN contains one measurement (air velocity) only, but in different unit (m/s, ft/min,
knots, km/h and MPH).

- DL151AN- 151 - X

Device  Graph

," Data \\ Graph "'._|
PLC storage range Earliest data:  29-03-2013 21:38:22 Latest data:  29-03-2013 21:40:03
¥ Surnmary |
All Data Export Excel ] [ E=port C5Y ]
Record Time Unitinss) ~
28-03-201 3 21:358:22 0.00
28-03-201 3 21:38:24 302
28-03-201 3 21:38:26 341
28-03-201 3 21:38:28 4.8
28-03-201 3 21:38:30 214
28-03-201 3 21:358:32 545
28-03-201 3 21:358:34 462
28-03-201 3 21:358:36 1.89
28-03-201 3 21:358:35 6.09
28-03-201 3 21:35:40 1.76
28-03-201 3 21:356:42 240
28-03-2013 21:35:44 1.19
28-03-201 3 21:35:46 1.20
28-03-201 3 21:35:45 2.2
28-03-2013 21:38:50 1.06
28-03-2013 2135852 080
28-03-2013 21:38:54 360
28-03-20M3 21:38:56 1.38
28-03-2013 21:38:58 1.60
28-03-201 3 21:35:00 335
28-03-201 3 21:35:02 449
28-03-201 3 21:35:04 1.83
28-03-2013 21:39:41 0.00
28-03-201 3 21:39:43 0.00
28-03-201 3 21:39:45 0.00
28-03-201 3 21:39:47 4 68
28-03-201 3 21:35:49 4 68
ORI % 2R g 151 ¥
1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.14.8 DL151AN — Graph View

~ DLLSLAN - 151 - X

Device  @raph
| Data / Graph \

DL151AN - 151

[ > Unit(m/s) ]
7 T T T T T T

Unit(m/s)

0 I e S S S e e B A I
21:38:11 21:38:41 21:39:11 21:39:41 21:40:11
29-03-2013 29-03-2013 29-03-2013 29-03-2013 29-03-2013

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values
6.14.9 DL151AN — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for DL151AN is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.
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6.15 DL200T / DL210TH / DL220THP

DL200T is a data logger for storing temperature.
DL210TH is a data logger for storing temperature and humidity.
DL220THP is a data logger for storing temperature, humidity and air pressure reading.

6.15.1 Add new DL200T / DL210TH / DL220THP

When Voltsoft detects a new DL200T / DL210TH / DL220THP attached, the following dialog will
be popped up:

Device Management System

Mew device detected, do wou want to add it inko the system now?

| s | [ Mo

Click “Yes”, the following dialog will be displayed:

Add New Device - F
Device Series Data Logger W
Maodel Mumber DLZHITHP W
Alias
Auto-Detect Add Close

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.15.2 Remove DL200T / DL210TH / DL220THP

To remove DL200T / DL210TH / DL220THP, go to Device Management -> Remove Existing
Device and its PC data Storage, select the device you want to remove and click the “Remove”
button.

124



Voltsoft User Manual

Version 2.5

6.15.3
| - DL220THP - DL220THP

DL200T / DL210TH / DL220THP — Device Control Panel

Device  Graph

/

PC storage range

i% i Summary

e \

Earliest data:  N/A

Latest data: N/A

Measurement

Maximum Value Kinimum Value

Average Value

All Data

Export Excel Export CSV

Record Time

The DL200T / DL210TH / DL220THP Device Control Panel contains follow items in menu:

1

10
11
12

Device -> Settings

Device -=> Download Data
Device -> Display / Plot Data

Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As

Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of DL200T /
DL210TH / DL220THP.

Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.15.4 DL200T / DL210TH / DL220THP - Settings

1  Logger Name

Input the unique alias for that device.

2 Logger ID

Logger ID is a four digit identifier. Enter a number
between 0000 and 9999 e.g. 0014.

2 Record Start Condition

"IMMEDIATELY UNTIL MEMORY FULL": Data logger
starts recording data immediately until the memory is
full.

"START UPON KEYPRESS": Data logger starts recording
after holding button ENTER pressed for few seconds.
Data logger stops recording until memory is full.

"START UPON START TIME": Data logger starts
recording at a defined date and time until the memory
is full.

"START/STOP TIME": Data logger starts and stops
recording data at a defined date and time.
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0 ~N O Ol

©

10

11

12

13

14

15

16

Stop Style

Start Time

Stop Time

Start Delay Minutes
Sampling Rate
Recording Time

LED Flash Interval

Enable Display

Enable LED Alarm

Limit Pause Function

Low Alarm / High Alarm

Language

PDF File Name

"CIRCULAR LOGGING": Data logger starts recording
immediately and circularly. The newest data overwrites
the oldest data. It stops recording/logging once the
battery is depleted or “CIRCULAR LOGGING” has been
replaced by another “RECORD START CONDITION”
during configuration.

"NONE": No stop condition is specified. Data logger
stops recording based on the "RECORD START
CONDITION" setting.

"STOP BUTTON": Data logger stops recording after
holding button ENTER pressed for few seconds.

"AFTER PDF CREATED": Data logger stops recording
after PDF report is generated.

Define date and time when to start recording data.
Define date and time when to stop recording data.
Define delay time of immediate start of recording.
Define how frequent the data logger measures and
records data in “SECONDS”, “MINUTES” or “HOURS”.
This value is automatically calculated based on the
sampling rate and cannot be set by the user.

Select how fast the LED control lights (2,3) shall flash.
Choose an interval of 5, 10, 15, 20, 25 or 30 seconds.
Remove the checkmark from the check box to turn off
the LC display, or check the checkbox to turn on the LC
display.

The LED alarm indicates when a measured value is
outside the defined range.

To disable the LED alarm, remove the checkmark in the
checkbox.

To enable the LED alarm, check the checkbox .
During recording, the limit alarm can be suspended.
Select “ENABLE” or “DISABLE” to enable/disable the
pause function.

Pause function will not stop the recording.

Select parameter(s) by checking parameter checkboxes
and specify the low and high alarm in numbers.

For air pressure, choose the desired unit from the drop
menu (DL-220THP only).

Choose the language, in which the PDF report shall be
shown, from the selection box.

Click on "INSERT NAME" to define the pattern of the file
name.

A new window "PLEASE CHOOSE THE NAME PATTERN
BELOW" opens. Choose the required elements
(OWNER/SERIAL
ID/MODELNAME/DATE/TIME/LOCATION) and their
order.

Up to 6 elements can be chosen. Chosen elements
appear in the field "FILE NAME".

Press "CLEAR" to delete all chosen elements. The field
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17
18
19
20

21

22

23

24
25

Date Format
Time Format
Oowner
Location

Report Title
User Text
Default Button

Create Configuration Button
Close Button

"FILE NAME" is empty again.

Press "CLOSE" to save the file name pattern and close
this window.

Select your prefered date format from menu
Select between 12 hour or 24 hour format.

Key in the owner’s name.

Key in the location’s name e.g. the name of the
location where you will record.

Enter a report title, which will be shown on the
PDF report.

Enter some remarks or additional information if
needed.

Reload the factory default settings.

Save changes.

Close this interface.

Note: Any stored data will be permanently erased when setup is finished.
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6.15.5 DL200T / DL210TH / DL220THP - Download Data

This module allows user to download the data from DL200T / DL210TH / DL220THP.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel ]

Click “OK” button to stop the recording and start downloading.

6.15.6 DL200T / DL210TH / DL220THP — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data - -
Real Time Data
(_) PC Storage Range Eariest data:  22-07-2016 22:54:14 Latest data: 22-07-2016 22:54:14
(@ From: 21072016 225205 [E~ To: 22072016 23:5208 [E~
Measurement Temperature “C v
Air Pressure (hPa) W
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 Measurement For DL200T / DL210TH, user can select Celsius or
Fahrenheit record to download.
For DL220THP, user can select air pressure unit too.
4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.
5 Close Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 will be returned.)
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6.15.7 DL200T / DL210TH / DL220THP — Data View

DL200T contain two measurement: Temperature and Pause.
DL210TH contain three measurements: Temperature, humidity and Pause.
DL220THP contains four measurements: Temperature, humidity, air pressure and Pause.

Pause will only have value 0 or 1 to indicate the limit alarm was suspended or not (1 =
suspended).

~" DL220THP - DL220THP - X

Device  Graph
/ Data \ Graph I\
PC storage range Eariest data:  22-07-2016 22.54:14 Latest data:  22-07-2016 23:23:14
A Summary
Measurement Maximum Value Minimum Value Average Value
Temperature *C (°C) 308 284 2956
Relative Humidity (%) 588 525 56.17
Air Pressure (hPa) 1009 1009 1,009.00
All Data Export Bxcel Export C5V
Record Time Temperature *C (°C) Relative Humidity (%) Air Pressure (hPa) Pause
22-07-2016 22:54:14 308 532 1009 0
22-07-2016 23:04:14 308 525 1009 0
22-07-2016 23:05:14 308 527 1009 0
22-07-2018 23:.08:14 308 571 1008 0
22-07-2018 23.07:14 307 54.1 1008 0
22-07-2018 23:08:14 304 54.1 1008 0
22-07-2018 23:08:14 302 544 1009 0
22-07-2016 23:10:14 30,0 552 1009 0
22-07-2016 23:11:14 288 557 1009 0
22-07-2016 231214 295 56.0 1009 0
22-07-2016 23:13:14 254 562 1009 0
22-07-2016 23:14:14 282 567 1009 0
22-07-2016 23:15:14 281 571 1009 0
22-07-2016 23:16:14 289 57.3 1008 0
22-07-2018 231714 289 57.5 1008 0
22-07-2018 23:18:14 288 577 1008 0
22-07-2018 23:19:14 287 58.1 1008 0
22-07-2016 23:20:14 286 582 1009 0
22-07-2016 232114 285 583 1009 0
22-07-2016 232214 28.4 586 1009 0
22-07-2016 232314 28.4 58.8 1009 0
1 Export Excel Export the reading to Excel (.xlIs) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.15.8 DL200T / DL210TH / DL220THP — Graph View
| "DL220THP - DL220THP | - %
[ Device  Graph
[ / Graph \
DL220THP - DL220THP
*  Temperature °C » Air Pressure (hPa)
Pause Relative Humidity
1060 , 315 | : : : : ‘ : ‘ - 60
1050 - - +1
1040 107 o
1030 E ! 8
© E 30.5 + i 2
] 0 T r —_
€100y N
© 1010 13 300 | @56 3
2 1D 1 st T
$ 1000 18 295 © & 55 38
Y 1€ T i =
@ 99 e T - 54 g
< 980 29.0 + i (14
970 = 1 - 53
] 285 | L 5o
960 - : o |
950 & 280 1 : = | , ; | ; L 51
22:51:00 23:06:00 23:21:00
22-07-2016 22-07-2016 22-07-2016

Our graph support following operations

1 Mouse wheel Zoom-in / Zoom-Out

2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.15.9 DL200T / DL210TH / DL220THP — Web Interface

DL200T, DL210TH and DL220THP are not available for web interface.
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6.16 PL-125-T2/PL-125-T4

PL-125-T2 / PL-125-T4 are data loggers for storing temperature reading. PL-125-T2 has two
channels while PL-125-T4 has four channels for measurement.

6.16.1 Add new PL-125-T2 / PL-125-T4
When Voltsoft detected a new PL-125-T2 / PL-125-T4 attached, the following dialog will be
popped up:

Device Management System

Mew device detected, do vou want ko add it into the swskem now?

Click “Yes”, the following dialog will be displayed:

\/ Add Hew Device

Cievice Series |Data Loager

Model Mumber  FISEE

Alias |

Auto-Detect ] [

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->=Add New Device in menu.

6.16.2 Remove PL-125-T2 / PL-125-T4

To remove PL-125-T2 / PL-125-T4, go to Device Management -> Remove Existing Device and
its PC data Storage, select the device you want to remove and click the “Remove” button.
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6.16.3 PL-125-T2 / PL-125-T4 — Device Control Panel
PL-125-T4 - PL-125-T41 l - X

Device  Graph
‘{ Data \' Graph \

PC starage rahge Earliest data:  11-07-2013 15:48:40 Latest data:  20-10-2013 23:33:56

¥ Summary

All Data Export Excel ] [ Export C5Y ]

Record Time

6.11.3 PL-125-T2 / PL-125-T4 contain follow items in menu:

1

2
3

10
11
12

Device -> Settings

Device -=> Download Data
Device -> Display / Plot Data

Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As

Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of PL125-T2 /
PL-125-T4.

Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.16.4

PL125-T2/ PL-125-T4 - Settings

PL-125-T4

18-06-2014 14:09:03 [~

Logger Name

Input the unique alias for that device.

N P

Time

Configure the device data time value.
The user can specify a defined time or use the system
date time.

Sample Rate

Instruct the logger to log readings at a specific rate.

Clear Device

Clear the memory on logger.

Default Button

Reload the factory default settings.

Setup Button

Save changes.

~N o o~ w

Close Button

Close this interface.
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6.16.5 PL125-T2 / PL-125-T4 - Download Data

This module allows user to download the data from PL125-T2 / PL-125-T4.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.16.6 PL125-T2 / PL-125-T4 — Display / Plot Data

This module allows user to select a range for the device readings from the device and display

them in the data tab and graph tab.

EEX

Display f Plot Data

Dizplay £ Plot [ata
() PC Starage Range Ealliest data;  05-02-2013 18:24:04  Latest data: 05-02-2013 18:35:29
) Fram: |04-DE-ED13 18:56:09 w To: |IIIE-EIE-2III131EI:EE:EIE w
Measurement | Temperature “C v |
| o || Close
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 Measurement User can select Celsius or Fahrenheit record to
download.

4 OK Click OK to accept the input and display the selected

reading in the data and graph tabs.
5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web

version, only the first 10,000 will be returned.)
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6.16.7

PL125-T2 / PL-125-T4 — Data View

PL125-T2 / PL-125-T4 are both measuring template. PL125-T2 will have two measurements
and PL125-T4 will have four measurements. Template unit can be Celsius or Fahrenheit,

depending on the selection in download page.

PL-125-T4 - PL-125-T41 ] - X
Device  Graph
{f Data \' Graph I".il

PC storage range Earliest data:  11-07-2013 15:48:40 Latest data:  20-10-2013 23:33:56

¥ Surirmary

All Data Export Excel ] [ E=part 54 ]
Record Time T1 (™2 T2 ("Ch T3 (") T4 (™C) ~
16-07-201318:23:15 258 255 255 251

16-07-201318:23:16 255 253 254 251

16-07-2013 182317 258 255 254 52

16-07-2013 18:24:52 26.3 256 253 2558

16-07-201318:24:53 26.3 256 233 238

16-07-2013 15:24:54 263 256 253 258

16-07-2013 18:24:55 262 256 253 257

16-07-2013 18:24:56 26.3 256 253 2548

16-07-2013 18:24:57 26.3 256 253 2548

16-07-2013 18:24:58 263 258 253 2548

16-07-201318:24:59 26.3 258 233 258

16-07-2013 18:25:00 263 256 255 258

16-07-201318:25M 263 256 255 2549

16-07-2013 18:25:02 26.3 257 255 w7

16-07-2013 18:25:03 263 257 255 287

16-07-2013 18:25:04 26.3 257 234 237

16-07-2013 18:29:05 262 256 254 257

16-07-201318:25.06 262 256 254 287

16-07-2013 18:25:07 262 256 254 w7

16-07-2013 18:25:08 282 258 252 287

16-07-2013 18:25:09 262 256 252 237

16-07-2013 18:25:10 262 256 252 257

16-07-2013 18:25:11 262 256 252 257 2

A8 AT AT A9 A 40

1 Export Excel
2 Export CSV

=]

Az T

Export the reading to Excel (.xls) format.
Export the reading to Excel (.csv) format.
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6.16.8 PL125-T2 / PL-125-T4 — Graph View

PL-125-T4 - PL-125-T41 ] - X

Device  Graph

Data / Graph \

PL-125-T4 - PL-125-T41

[ T10°D) TZ(FC] = T3(°C) T4°CY |
29 . .

2371
T
26 T

25 1

Temperature °C

24 F

23 1

22 : . . . } . . ' } ' . . | . i i
00:00:00 00:00:00 00:00:00 00:00:00 00:00:00
01-07-2013 01-08-2013 01-09-2013 01-10-2013 01-11-2013

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out

2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values
6.16.9 PL125-T2 / PL-125-T4 —Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for 6.11.9PL125-T2 / PL-125-T4 is the same as Windows version, except the
downloaded data can only have 10,000 reading in a single download.
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6.17 IR 1200-50D / IR 1201-50D
IR 1200-50D / IR 1201-50D is a data logger for measuring temperature.

6.17.1 Add new IR 1200-50D / IR-1201-50D

When Voltsoft detected a new IR 1200-50D / IR 1201-50D attached, the following dialog will
be popped up:

Device Management System

Mew device detected, dao wou want ta add it inka the swstem now?

Click “Yes”, the following dialog will be displayed:

\/ idd New Device

Device Series |Data Logger

haodel Mumber |IF| 1200-500

Alias 1200500

[.i'-.utu:--Detect ] [ Add l [ Cloze ]

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.17.2 Remove IR 1200-50D / IR-1201-50D

To remove IR 1200-50D / IR 1201-50D, go to Device Management -> Remove Existing Device
and its PC data Storage, select the device you want to remove and click the “Remove” button.
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6.17.3 IR 1200-50D / IR-1201-50D — Device Control Panel
/TR 1200-50D - 1200 | - X
- Device  @raph
/ Data \' Graph \
PC storage range Earliest data:  05-03-2013 16:56:25 Latest data:  Current Time
¥ Summary
All Data [ Export Excel ] [ Export CSY ]
Record Time IR (72
| s | [ Bosmeadlosser |
EMS: O
IR Max: |0 IR Min:|0
IR AVG: |0 IR DIF:|O
IR: O C
TK: N / ﬂ
1/1/0001 12:00:00 AM
< ¥

The IR 1200-50D / IR 1201-50D Device Control Panel contains the follow items in menu:
This will launch the setting page of IR 1200-50D.

1 Device -> Settings
2 Device -> Display / Plot Data

3 Graph -> Plot Colour

4 Graph -> Background Colour
5 Graph -> Grid

6 Graph -> Line

7 Graph -> Points Indicator

8 Graph -> Print

9 Graph -> Save Image As

10 Graph -=> Zoom Out
11 Graph -> Zoom To Fit

Select the time range that the device reading
should be retrieved.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.

139



Voltsoft User Manual Version 2.5

6.17.4 IR 1200-50D / IR-1201-50D — Settings

/1200 - Settings (HW ID:0018_13012400001) A=

Logoer Mame: |'IEIIIIII |

mample Fate

I 4| Second v
| Setup | | Close
1 Logger Name Input the unique alias for that device.
2 Sample Rate Instruct the data logger to log readings at a specific
rate (for real time mode only).
3 Setup Button Save changes.
4 Close Button Close this interface.
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6.17.5 IR 1200-50D / IR-1201-50D — Play (Real Time Mode)

Click the “Play” button in device control panel will switch IR 1200-50D / IR 1201-50D into real
time mode and the button label will become “Stop”, click it again to leave real time mode.

IR 1200-50D - 1200

Device  Graph

I Data \ Graph I".ll
PC starage range Earliest data:  05-03-2013 16:56:25 Latest data:  05-03-2013 17:03.20
¥ Summary |
All Data [ Export Excel ] [ Export C5Y ]

In real time mode, pressing the trigger on the device will start sending data to PC, no data will
be sent if the trigger is not pressed.

" IR 1200-50D - 1200

Dewvice  Graph

/ Data \' Graph II‘.‘
PC storage range Earliest data:  05-03-2013 16:56:25 Latest data:  Curent Time
¥ Surmmary |
All Data [ E=port Excel ] [ Expart C5Y ]
Record Time IR (%)
| sep | [ Bowiesiloner |
EMS: O
IR Max: |0 IR Min:|0
IR AVG: |0 IR DIF:|O

IR: O C
“INTA

1/1/0001 12:00:00 AM
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6.17.6 IR 1200-50D / IR-1201-50D — Download Store Data

Click the “Download Logger” button in the device control panel will trigger the download data
action, and the following dialog will be popped up:

~ IR 1200-50D - 1200 - X

Device  Graph

/ Data \ Graph "'.,
PC storage range Earliest data:  05-03-2013 16:56;25 Latest data: 05-03-201317:03:20
¥ Summary
All Data Export Excel ] [ Export CSY
Record Time IR

To download data from device:

1) Enter the "Set" menu of the device

2) Press the up and down arrow softkey to select Send data
3) Press the Set softkey to enter Send data setting

4) Press the up and down arrow softkey to select memory.
5) Press the Ok softkey

Cancel

Connected

Follows the instructions displayed, if success, the dialog will dismiss and data will be displayed.

| IR 1200-50D - 1200 - X

Device  Graph

| /‘ Data \' Graph II"'.

PC storage range Earliest data:  05-03-2013 16:56:25 Latest data: 03-04-2013 23:05:38
| % Summary
1 All Data [ Export Excel ] [ Export CSY ]

Record Time IR (%) EMZ TH (C)

03-01-2013 14:33:00 234 0.495

03-01-2013 143320 2.8 0.95

03-01-2013 14:335:40 35.0 0.495

03-01-201 3 143700 222 0.5

03-01-2013 14:37:30 35.5 0.95

03-01-2013 18:10:00 246 0.495

02-02-201 3 19:20:00 30 0.5

02-02-2013 19:20:30 330 0.95

05-02-2013 17:00:00 256 0.495

03-04-2013 23:10:00 252 0.85

03-04-2013 23:10:30 276 0.95

£ >
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6.17.7 IR 1200-50D / IR-1201-50D — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display / Plot Data
Dizplay / Flat Data
() PC Storage Range Earliest data:  05-03-2013 16:56:25 Latest data; 05-03-2013 17:09.20
+) From: 3A0-03-2013 23:52:20 hd Tao: |01-04-2013 00:52:20 b
teasurement Temperature “C v
ok || ciose
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 Measurement User can select which measurement unit to download.
4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.17.8 IR 1200-50D / IR-1201-50D — Data View

IR 1200-50D / IR 1201-50D contains one measurement (Temperature) only, its unit can be
Celsius or Fahrenheit, can be selected in Display / Plot Data dialog.

IR 1200-50D - 1200 - X

Device  Graph

f/ Data \( Graph II".II

PC storage range Earliest data:  05-03-2013 16:56:25 Latest data:  05-03-2013 17:09:20

¥ Summary
| All Data [ Export Excel ] [ Export C5Y

Record Time IR (5%C) EMS

05-03-2013 16:56:26 234 0495

05-03-2013 16:56:27 238 04as

05-03-2013 16:56:29 225 095

05-03-201317:0912 284 04as

05-03-201317:09:13 284 04as

05-03-201317:09:14 2849 0495

05-03-201317:09:15 291 04as

05-03-201317.0916 291 095

05-03-201317:0917 281 04as

05-03-201317:09:18 281 04as

05-03-201317:09:19 291 0495

05-03-201317:09:20 290 04as

< >
1 Export Excel Export the reading to Excel (.xlIs) format.
2 Export CSV Export the reading to Excel (.csv) format.
3 Play Enter the real time mode.
4 Download Logger Download stored data in device.
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6.17.9 IR 1200-50D / IR-1201-50D — Graph View
/m - X
. Device  Graph
Data / Graph \
IR 1200-50D - 1200
[ R(C) TK(C) X EMS |
30 1 T T T T I T T T T | T T T T 1 1.00
29 = 1099
2 1 10098
i 1097
o 27 + 1
o 1 1096
5 26 + 1
b I 1 o
© i J( > 4 + 095 =
a8 25 + I L
z T + 0.94
- 24 I 1
1093
23 1 1 0.92
22 + 1 0.91
21 1 } } } } ! } " } } | } } " } | 1 0.90
16:55:00 17:00:00 17:05:00 17:10:00
05-03-2013 05-03-2013 05-03-2013 05-03-2013

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values

6.17.10 IR 1200-50D / IR-1201-50D — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for IR 1200-50D / IR 1201-50D is the same as Windows version, except the
downloaded data can only have 10,000 readings in a single download.
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6.18 SL451

SL451 is a data logger for storing sound level reading. SL451 support real time measurement.

6.18.1 Add new SL451

To add SL451 to Voltsoft, first connect SL451 to PC via USB port, press the “SETUP” button on
the device until the circle icon (on lower left corner) disappears. When Voltsoft detected a new
SL451 attached, the following dialog will be popped up:

Device Management System

Mew device detected, do vou want ko add it into the swskem now?

Click “Yes”, the following dialog will be displayed:

\/ #dd Mew Device

Device Series |Data Logger

Model Number  SL451

Alias 51

[.-’-‘-.utu::-Deteu:t ] [ Add l [

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by select Device Management-=>Add New Device in menu.

6.18.2 Remove SL451

To remove SL451, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.18.3

SL451 — Device Control Panel

< SL451 - 451

v X

Device  Graph

Data \

Graph I"‘

PC storage range Earliest data:  M/2

Latest data: N/

Measurement hazcimum alue
Sound Level dBA,

Sound Level dBC

Minimum W alue Average Value

All Data

Recard Time Sound Level dBA

Export Ewcel H Enport C5Y

Sound Level dBC

The SL451 Device Control Panel contains the following items in menu:

A WN PR

al

10

11

12
13
14
15
16

Device -> Settings

Device -> Stop

Device -=> Download Data
Device -> Display / Plot Data

Device -> Email Alert

Device -> Calibration
Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As
Graph -> Zoom Out

Graph -> Zoom To Fit
Graph -> View All Data

This will launch the setting page of SL451.
Stop the real time data download.

Download reading from device.

Select the time range that the device reading
should be retrieved.

This will launch the email alert module.
(Available in Professional version only)
Launch the calibration module.

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.

Zoom out the graph to view all data.
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6.18.4 SL451 — Settings

\/ 451 - Settings (HW ID:0006_1210170003)

Basic Settings
Logger Mame 15

Fleaze change the device settings by using the
hardware key on the device.

Sample Rate 182 |

Sample Points 40000 5| [ Infinite

Alarm Settings

sound Low Level a0 Z|dB High Level 130 5 dB
sound Low Level |30 2 dB High Level 130 3 dB
Device connect.
[ Default ] [ Setup ] [ Cloze ]
1 Logger Name Input the unique alias for that device.
2 Sample Rate Instruct the data logger to log readings at a specific
rate.
3 Sample Points Configure the data logger sample points.
4 Infinite For real time mode only, the download will not stop
until the user stopped the download.
5 Low / High Alarm for dBA Configure the sound level (at unit dBA) for the low /
high alarm level.
6 Low / High Alarm for dBC Configure the sound level (at unit dBC) for the low /
high alarm level.
7 Default Button Load the factory default settings.
8 Setup Button Save changes.
9 Close Button Close this interface.
6.18.5 SL451 - Download Data

This module allows user to download the data from SL451, it will download the data when user
pressed the “REC” button on the device.

Download Data

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel ]

Click “OK” button to stop the recording and start downloading.
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6.18.6 SL451 — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplay/Plat Data
() PC Storage Range Earliest data: WAL Latest data: Currert Time

) From: 26-01-2013 17:38:17 hd Ta: | 27-01-2013 18:38:17 v

() Real Time Data

Device connect.

| ox || cose |

1 PC Storage Range Download all data stored in the database.

2 Time Range Select the data reading range.

3 Real Time Data Download real time data, will only enable if the device
in real time mode. (by press the “Setup” button in
Settings)

4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.18.7 SL451 — Data View

SL451 contains two measurements (sound level in dBA and sound level in dBC), the device can
record only one measurement at any specific unit of time (by press the “A/C” button on
device).

< 5L451 - 451 - X

Device  Graph

/ Data \' Graph II\'.,

PC storage range Earliest data:  27-01-2013 22:58:14 Latest data:  27-01-2013 22:58:45

¥ Summary |
. All Data Export Excel ] [ Export C5Y ]

Record Time Sound Level dBA, Sound Lesvel dBC

27-01-2013 22:58.24 1.3

2T-01-2013 22:58:25 s0.7

27-01-2013 22:58.26 a1

27-01-2013 22:58.27 a0.7

27-01-2013 22:58.28 51.2

2T-01-2013 22:58:29 5049

27-01-2013 22:58:30 211

27-01-2013 22:58. 31 a1

27-01-2013 22:58.32 515

2T-01-2013 22:58:33 s0.8

27-01-2013 22:58.34 a1

27-01-2013 22:58.35 508

27-01-2013 22:58.36 507

2T-01-2013 22:58:37 503

27-01-2013 22:58.38 a0.3

27-01-2013 22:58.39 a1

27-01-2013 22:58:40 503

2T-01-2013 22:58 41 a0.5

27-01-2013 22:58.42 a0.7

27-01-2013 22:58.43 s049

27-01-2001 4

1 Export Excel Export the reading to Excel (.xlIs) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.18.8 SL451 — Graph View
~ SL451 - 451

Device  Graph

Data / Graph \

SL451 - 451

Sound Level dBC |

[ % Sound Level dBA
518 ————————

51.6 1
514 1
512 1
51.0 1

508 I

Sound Level

506
504 1

502 F

t t t : | : t } t
22:58:20 225820 225840
From:27-01-2013 22:568:23 To:27-01-2013 22:58:44

225850

Our graph supports the following operations

1 Mouse wheel Zoom-in / Zoom-Out
2 Mouse click and drag Zoom-in

3 Shift + mouse click Pan

4 Mouse over on point Display reading values
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6.18.9 SL451 — Email Alert

\/ Email Alert [Z| |E|f'5__<|

R ecipient|=] Lizt

Following receipient[z] will receive email alert

johnemitEgrail. com

As SL451 supports real time measurement, therefore, it has an email alert feature, which wiill
send out an email to the specified user when the device reading is above or below a certain
level. The alert level can be configured in Setting.

User can use this module to select who will receive the email for the specific device.

6.18.10 SL451 — Web Interface

Please refer to section 5.6 on how to launch the web interface.

The web interface for SL451 is the same as Windows version, except the downloaded data can
only have 10,000 readings in a single download.
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6.19 VC930/VC950

VC930 / VC950 are DMM devices which measure a number of different measurements.

6.19.1 Add new VC930 / VC950
When Voltsoft detected a new VC930 / VC950 attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want to add it inko the system now?

Click “Yes”, the following dialog will be displayed:

\/ #dd Hew Device

Device Series |DMM

Model Nurmber | V330

Alias 330

[.ﬁ.utD-Detect ] [ Add l [ Cloze ]

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.19.2 Remove VC930 / VC950

To remove VC930 / VC950, go to Device Management -> Remove Existing Device and its PC
data Storage, select the device you want to remove and click the “Remove” button.
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6.19.3

VC930 /VC950 — Device Control Panel

Device  Graph

i

PC storage range

¥ Summary

Data

\..

Graph

Earliest data:  15-05-2011 06:29:52

Latest data: Current Tirne

Real Time Mode

Record Time
16-06-2011 12:39:39
16-06-2011 12:40:00
16-06-2011 12:40:01
16-06-2011 12:40:02
16-06-2011 12:40:03
16-06-2011 12:40:04
16-06-2011 12:40:05
16-06-2011 12:40:06
16-06-2011 12:40:07
16-06-2011 12:40:08
16-06-2011 12:40:09
16-06-2011 12:40:10
16-06-2011 12:40:11
16-06-2011 12:40:12
16-06-2011 12:40:13
16-06-2011 12:40:14
16-06-2011 12:40:15
16-06-2011 12:40:16
16-06-2011 12:40:17
16-06-2011 12:40:18
16-06-2011 12:40:19
16-06-2011 12:40:20
16-06-2011 12:40:21
16-06-2011 12:40:22
16-06-2011 12:40:23
16-06-2011 12:40:24

Reading Unit Function
273 °C Temp.
ric) °C Temp.
73 o Temp.
273 °C Temp.
273 °C Temp.
273 o Temp.
272 s Temp.
272 °C Temp.
e o Temp.
27E o Temp.
275 °C Temp.
275 °C Temp.
274 o Temp.
275 o Temgp.
275 °C Temp.
L) o Temp.
a7 o Temp.
275 °C Temp.
i) °C Temp.
274 o Temp.
274 o Temgp.
273 °C Temp.
72 o Temp.
272 s Temp.
2TE °C Temp.
274 °C Temp.

hocle

[ Export Excel ] [ Export C5W ]

Stop Dizplay

l

216

100

Temp.

The VC930 / VC950 Device Control Panel contains the following items in menu:

1

10
11
12
13

Device -> Data Record Settings

Device -=> Download Data
Device -> Display / Plot Data

Device -> Email Alert

Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As

Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of VC930 /
VC950.

Download reading from device.

Select the time range that the device reading
should retrieve.

This will launch the email alert module.

(Available in Professional version only)

This will launch the Plot Colour module to change

the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.

154



Voltsoft User Manual

Version 2.5

6.19.4

VC930 / VC950 - Download Data

This module allows user to download the data from VC930 / VC950.

Download Data

{(#) Dowrload D atal og

Device dizconnect.

=3

() Download Storage

Cloze

OF.

Click “OK” button to stop the recording and start downloading.

6.19.5

VC930 / VC950 — Settings
\/ W950, - Settings (HW ID:0008_00000001)
Basic Settings
Logger Marme 950
Sample Paoints 40000 3 [ ] Infinite
Sample Rate 15 |»
Alarm Settings
Measurernent AC (W) -
AC V) Low Level 0 High Lewel 1000
Device disconnect. I Setup l l Cloze

Logger Name
Sample Points
Infinite

Sample Rate
Alarm Settings*

Setup Button
Close Button

Input the unique alias for that device.

Configure the data logger sample points.

For real time mode only, the download will not stop
until the user stopped the download.

Instruct the data logger to log readings at a specific
rate.

Select the measurement column and alarm level.
Save changes.

Close this interface.

* Note: The alarm can be configured in the following measurement ranges:

Unit Function Mode Unit Function Mode

\ AC - % mA AC %
\ DC - % mA DC %
\ AC+DC - % mA AC+DC %
\ AC O A AC -
\ DC O A DC -
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6.19.6 VC930 / VC950 — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display / Plot Data

Dizplay / Plat Data
) PC Storage Range Earliest data:  NAA Latest data: MA

& From: 23-03-2131316:27 s Ta: | 24032013 141627 b

Measurement AL Y] w

1 PC Storage Range Download all data stored in the database.

2 Time Range Select the data reading range.

3 Measurement User can select which measurement record to
download.

4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.19.7

VC930 / VC950 contains many different measurements, you will need to specify which

VC930 / VC950 — Data View

measurement (and unit) to download in “Display / Plot data” dialog.

Device

araph

|

PLC storage range

Data

Earliest data:  24-03-201313:17:19

\ Graph '\\

Latest data: Current Time

¥ Summary
| History Data 3 [ Back ta real time mode I Eanai Facel | [ Eonort [ |
Record Time Reading Unit Function Made 1 Slop Recard 1 [ Stop Display l
|| 24-m3-2m313719 277 my ac
24-03-2013 134721 275 my AC
| 24-03.20131317.22 275 m ac
24-03-20131317:23 2565 m ac ﬂ 5 1 n
24-03-20131317:24 268 my aC
24.03-2M31317:25 268 i ac e
24.03.20131317:26 2565 my ac
24-03-2131317:28 2565 m ac
24-03-20131317:20 2565 my AC n
24.03-2131317:30 265 m ac
24.032013 131731 2565 my ac
24-03-20131317:32 2565 m ac
24-M20131I17T 263 m o AC 2 AG
24.03-20131317:3¢ 2565 m ac
24-03-20131317:36 264 m ac
24-03-20131347:37 254 my aC
24.03-20M3 134738 264 i ac
24.03-20131317:39 2565 my ac
24-03-20131317:40 268 m ac
24-032013 134741 266 my AC
24.03-21131317:42 268 m ac
24-03-20131317:43 266 m ac
24-03-20131317:44 268 m ac
24-03-20131317:46 255 my AC
24.03.20131317:47 254 m ac
24-03-20131317:48 264 m ac
24-03-20131347:40 254 my aC 1 m“
24.03-2M31347:50 264 i ac
24.03.20131317:52 263 my ac L
24-03-2131317:54 2563 m ac
24-03-20131317:55 263 my AC
24.03-21M3 131756 262 m ac
24-03-20131317:57 282 m ac
24-03-20131317:59 2562 m ac
24-03-20131316:00 252 my AC
24.03.2013 131801 282 m ac
24-03-2131318:02 262 m ac
24-03-2013 131808 261 my aC
24.03-2113 131604 261 m ac
24.03-20131318:05 261 my ac
24-03-2131318:07 260 m ac @

1

2
3

Record / Display

Button

Display Area
Back to real time

mode

Use these two buttons to toggle between display and record
mode.

In display mode, the reading measured by the device will
be displayed in the display area.

In record mode, the reading measured will not only display
in the display area, but also be stored in the database for
future use.

N.B.

i) If the device is in record mode this means it is also in
display mode.

ii) Stopping the display mode will also stop the record
mode.

Display the measured value.

This button will display when the device is in real time
mode but the interface is not showing real-time data (e.g.
downloading log data / historical data).

Clicking this button can return the interface to display real-
time data.
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6.19.8 VC930 /VC950 — Graph View

Data / Graph
VC950 - 950
< AC(V) |
280 T T T T I T T T
275 |
< 270 4
E
0 T
< 265 +
2.60 +
I P
255 Lp i
13:17:42 13:17:46 13:17:50 13:17:54 13:17:58 13:18:02 13:18:06 13:18:10
From:24-03-2013 13:17:19 To:24-03-2013 13:18:10

Our graph supports the following operations

1 Mouse wheel

2 Mouse click and drag
3 Shift + mouse click
4 Mouse over on point

Zoom-in / Zoom-Out

Zoom-in
Pan

Display reading values
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6.19.9 VC930 / VC950 — Web Interface

Please refer to section 5.6 on how to launch the web interface.
The web interface for VC930 / VC950 is similar to the Windows version, except two points:
1. Downloaded data can only have 10,000 readings in a single download.

2. The status of the “Record” and “Display” button will not be refreshed automatically. A
“Refresh” button was therefore added, so click on the button to refresh the button status.

V850 - 850 @l
Device Graph
Diata Graph
PC storage range Eatliest data; 24-03-2013 1317:19 Latest data: 24-03-2013 131810 *
¥ Summary
l Export C3Y ] [ Export Excel ]
Record Time Reading Unit Function Mocle | ﬁ _
0 0 0
0 -
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6.20 VC880 /VC650BT

VC880 / VC650BT are DMM devices which measure a number of different measurements.

6.20.1 Add new VC880/VC650BT

To add VC880 / VC650BT to Voltsoft, first connect the device to PC via USB port, press “REL /
PC” button on the device until the PC icon appear. When Voltsoft detected a new VC880 /

VCB850 attached, the following dialog will be popped up:

Device Management System

Mew device detected, do wou want ko add it into the swskerm now?

Click “Yes”, the following dialog will be displayed:

\/ Add New Device

Device Series |DMM vl
Model Mumber  C350 v/
Alias 880 |

[.-i'-.utn:n-Detec:t ] [ Add ] [ Cloze ]

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by selecting Device Management->Add New Device in menu.

6.20.2 Remove VC880 / VC650BT

To remove VC880 / VC850BT, go to Device Management -> Remove Existing Device and its PC
data Storage, select the device you want to remove and click the “Remove” button.
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6.20.3 VC880 / VC650BT — Device Control Panel
[ Device  Graph
/ Data \ Graph
PC storage range Earliest data: 02-12-201213:3313 Latest data:  02-12-2012 13,3821
¥ Summary |
Real Time Mode Back ta real time mode l Export Excel ] [ Export CSY ]
Recaord Time Function Reading Unit Ranoe Sub Y [ Stop Record l [ Stop Display ]
02-12-2012 19:38:13 DY 026 m (=] u] Device Control
02-12-201219:3514 DY 0.26 my 600 o
[ ManualRangs | [ AuoRange | [ maminiave || ExtWax | [ NGBesp |[  Light |
[ et [ Hud REL | [ PassBesp | [ COMP value |
[ Single Log ] [ Series Log ]
[ Load Device Memary ] [ Clear Device Memary ]
[ Load Carmparizan Memory H Clear Carmparisan Memaony ]
000.21 -
- 0 1 2 3 4 5 BOOMY
|
< ¥

The VC880 / VC650BT Device Control Panel contains the following items in menu:

1

2

10
11
12

Device -> Data Record Settings
Device -> Display / Plot Data

Device -> Email Alert

Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As

Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of VC880 /
VC650BT.

Select the time range that the device reading
should retrieve.

This will launch the email alert module.

(Available in Professional version only)

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.20.4 VC880 / VC650BT — Settings

\/IVCBRO - Settings (HW ID:0009-000000000000507)

Basic Settings
Logger Mame

sample Paints

Sample Rate

Alarm Settings

heasurement

Device dizconnect.

Lo Level

[vCEa0
40000

15 w

Skip repeat reading

Function

ACHDC Y

a

% [ Infinite

LInit fode
b A b A& w

High Level (1000

I Setup ] [ Cloze

1 Logger Name
2 Sample Points
3 Infinite

4 Sample Rate

5 Skip repeat reading

6 Alarm Settings™*
7 Setup Button
8 Close Button

Input the unique alias for that device.

Configure the data logger sample points.

For real time mode only, the download will not stop
until the user stops the download.

Instruct the data logger to log readings at a specific
rate.

System will not record a duplicate reading if this option
was checked.

Select the measurement column and alarm level.
Save changes.

Close this interface.

* Note: The alarm can be configured in the following measurement ranges:

Function Unit Mode
AC+DCV Vv N/A
AC+DCV V A
ACV Y N/A
ACV Vv A
DCV Vv N/A
DCV Vv A
DCV mV N/A
DCV mV A
ACA HA N/A
ACA A N/A
ACA mA N/A
ACA HA A
ACA A A
ACA mA A
Continuity Q N/A
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Diode Vv N/A
Duty Cycle % N/A
DCA A N/A
DCA A N/A
DCA mA N/A
DCA LA A
DCA A A
DCA mA A
Capacity uF N/A
Capacity mF N/A
Capacity nF N/A
Capacity WF A
Capacity mF A
Capacity nF A
Freq Hz N/A
Freq kHz N/A
Freq MHz N/A
Impedance Q N/A
Impedance kQ N/A
Impedance MQ N/A
Temperature °C N/A
Temperature °F N/A
ACV Low-pass \Y; N/A
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6.20.5 VC880 / VC650BT — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display / Plot Data Q‘Elg‘

Dizplay / Plat D ata
() PC storage rangs Earliest data:  24-03-2013 21:26:18 Latest data: 24-03-2013 21:23:16

(& From 2303-201321:31:45 Too | 24-032013 223145 v

Measurernent
Function Unit Maode

ACDCY v W v MN/& b

1 PC Storage Range Download all data stored in the database.

2 Time Range Select the data reading range.

3 Measurement User can select which measurement record to
download.

4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.20.6 VC880 / VC650BT — Data View

VC880 / VCB650BT contains many different measurements, you will need to specify which
measurement (and unit) to download in “Display / Plot data” dialog.

Device  Graph

(l Data

PC storage range Earliest data:  24-03-2013 21:26:18

¥ Summary

\ Graph ".‘

Latest data:  Current Time

Back to real time mode

]

4 [ E =poit Excel ] [ E=port C5W ]

Record Time Function Reading
|| 24-03-2013 21260118 DOV 023
24-03-2013 2112618 DOV k]
24-03-2013 21:26:20  DCY o1
24-03-2013 21:26:21 DY 005
24-03-2013 21:26:22 DOV oos
24-03-2013 21:26:23 DOV o1z
24-03-2013 21:26:24 DOV oor
24-03-2013 21:26:25 DOV 008
24-03-2013 21126126 DOV o004
24-03-2013 21:26:27  DCV onz
24-03-2013 21:26:26  DCY oo
24-03-2013 21:26:29 DOV oo
24-03-2013 21:26:30 DOV o

24-03-2013 21:26:3 DOV
24-03-2013 21:26:32 DOV
24-03-2013 21:26:33 DOV
24-03-2013 21:26:34 DOV
24-03-2013 21:26:35 DOV
24-03-2013 21:26:36 DOV
24-03-2013 21:26:37 DOV
24-03-2013 21:26:38  DCV
24-03-2013 21:26:38 DOV
24-03-2013 21:26:40 DCV
24-03-2013 21:26:41 DOV
24-03-2013 21:26:42  DCY
24-03-2013 21:26:43 DOV
24-03-2013 21:26:44 DOV
24-03-2013 21:26:45 DOV
24-03-2013 21:26:46 DOV
24-03-2013 21:26:47 DOV
24-03-2013 21:26:48  DCY
24-03-2013 21:26:49  DCV
24-03-2013 21:26:50 DOV
24-03-2013 21:26:51 DOV
24-03-2013 21:26:52 DOV

CoocoOoOCcocOoO0OOCOoOOCOoOOOCOoOOoOOoOOoOO

24-03-2013 21:26:53  DCY

24-03-2013 21:26:54 DOV -012
24-03-2013 21:26:55 DOV o0z
24-03-2013 21:26:56  DCY 0n0e
24-03-2013 21:26:57 DOV 013
T4 A WA MIEER DR nm

1 Record / Display
Button

2 Command Button

3 Display Area

4 Back to real time
mode

Unit
m
m
m
m
m
m
m
m
m
mh
mh
m
m
m
m
m
m
mh
m
m
mh
m
m
m
m
m
m
m
mh
m
m
mh
m
m
m
m
m
m
mh
mh

e

Range
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
400
Ann

Sub Value | Mode A

PR T 1 Stop Record Stop Dizplay
evice Lontrol

[ MarualRange | [ awoRange | [ wmaminave | [ Exitvax |
[ seex [ heod REL ]

[ Single Log ] [ Series Log ]

[ Load Device Memory H Clear Device Memaory I 2

],

-000.05

Manual 400

mV

0 10 20 30 40

Use these two buttons to toggle between display and record
mode.

In display mode, the reading measured by the device will
be displayed in the display area.

In record mode, the reading measured will not only display
in the display area, but also be stored in the database for
future use.

N.B.

i) If the device is in record mode this means it is also in
display mode.

ii) Stopping the display mode will also stop the record
mode.

Refer to below section.

Display the measured value.

This button will display when the device is in real time
mode but the interface is not showing real-time data (e.g.
downloading log data / historical data).

Clicking this button can return the interface to displaying
real-time data.
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Command Button
Manual Range
Auto Range
MAX / MIN / AVG
Exit Max
NG Beep
Light
Select
Hold
REL
Pass Beep
COMP Value
COMP Setting
Single Log

Series Log

Load Comparison Memory

Clear Comparison Memory

Load Device Memory

Clear Device Memory

Data Comparison dialog

Click to send commands to make device entering the
manual range.

Click to send commands to make device entering the
auto range.

Click to send commands to enable maximum, minimum,
average function.

Click to send commands to exit maximum, minimum,
average function.

In the COMP VALUE mode, if failed, click button to turn
the alarm on/off.

Click to send commands to enable device backlight
function, and then click the exit functions.

Click to send commands to enable device function
selection.

Click to send commands to enable device to maintain the
function, and then click to exit maintain function.

Click to send commands to enable the relative value
function; then click to exit the function.

In the COMP VALUE mode, if passed, click button to turn
the alarm on/off.

Enter / Leave COMP value mode.

Pop up Data Comparison dialog.

Click to send commands to enable device to store a
single data.

Click to send commands to enable device to continuously
store data, and then click to exit the function.

Click to send commands to send out the comparison data
stored by device.

Clear the comparison data in device.

Click to send commands to send out the no comparison
data stored by device.

Clear the no comparison data in device.

High Lirnit
Lvwe Lirmit

Inner { Cuter

Cloze

Setup Enter

TS
High Lirnit pooez S [
Lo Lirnit noozo %
Inner/ Quter  |Inner w o
E E
I

Setup Enter : When button is pressed, the upper/lower limit and the mode can be modified;
when button is up, the settings will be sent and saved in the device.
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6.20.7 VC880 / VC650BT — Graph View
Data Graph \
VC880 - 880
05 T . ‘ :
04 T
0.3
02
T
o 0.1
o
0.0
-0.1
0.2
-0.3 T : : | : : : | : : | : :
21:26:00 21:27:00 21:28:00 21:29:00 21:30:00
24-03-2013 24-03-2013 24-03-2013 24-03-2013 24-03-2013
Time

Our graph supports the following operations

1

2
3
4

Mouse wheel

Mouse click and drag
Shift + mouse click
Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values
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6.20.8 VC880 / VC650BT — Web Interface

Please refer to section 5.6 on how to launch the web interface.
The web interface for VC880 / VC650BT is the similar to Windows version, except two points:
1. Downloaded data can only have 10,000 readings in a single download.

2. The status of the “Record” and “Display” button will not be refreshed automatically. A
“Refresh” button was therefore added, so click on the button to refresh the button

status.
YG80- 680 |
Device Graph
Data Graph
PC storage range Earliest data: 24-03-2013 21:26:18 Latest data: 24-03-2013 21:29:16
¥ Summary
[ Export CSY ] [ Expart Excel ]
Record Time Function Reading Uni _ Star Fecord Start Display
Cormmand Key
[ ManualRange | [ sutoRange | [ maxmimevs | | Exit M il NG Beep il Light |
[ Select il Hald il REL J[ PasBeep | coMPvalue | [ COMP Setting |
[ Single Log ][ Series Log ][ Load Comparison hemony ][ Load Device Memony ]
[ clear Comparisan Memars | [ Clear Device Memary |
MEN - -
Auto
£ ?
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6.21 VC890

VC890 is a DMM device which measures a number of different measurements.

6.21.1 Add new VC890

To add VC890 to Voltsoft, first connect the device to PC via USB port, press “REL / PC” button
on the device until the PC icon appears. When Voltsoft detected a new VC890 attached, the
following dialog will be popped up:

Device Management System

Mew device detected, do wou want ko add it into the swskerm now?

Click “Yes”, the following dialog will be displayed:

\/ idd New Device

Device Series | DMM v

Model Murnber | vCaan |

Alias 830 |

[Auto-Detect ] I Add l [ Close ]

Enter a unique alias for this device, click “Add” will add the device into Voltsoft. User may also
launch this module by select Device Management->Add New Device in menu.

6.21.2 Remove VC890

To remove VC890, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.
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6.21.3 VC890 — Device Control Panel
Device  Graph
/ Data \
PC storage range Earliest data:  24-03-2003 22:02:05 Latest data:  Current Time
| % Summary
| Real Time Mode [ Export Excel ] [ Export C5Y ]
Record Time Function Reading Unit Range | Sub Value [ Stop Record ] l Stop Display l
24-03-2013 220205 DCY 045 m 600 - Device Control
24-03-2013 2202068 DCY 046 m BO0
24.03-2013 220207 DOV 045 my 600 [ Manual Range ] [ Auto Fange ] [ A AV G ] [ Exit Max ] [ NG Beep ] [ Pass Beep ]
24-03-2013 220208 DCY 045 m 600 -
24039013 220210 DOV 045 v B0 [ | hod  J[ ReL | [ Lght | [ coMPvake | [ COMPSeting |
24-03-2013 220211 DCY 043 m 600 -
24032013 220212 DOV 045 my 600 - [ Single Log ] [ Series Log ]
24-03-2013 220213 DCY 045 m 600 -
24.03-2013 22:0215 DOV 045 Y 500 [ Load Device Memary ] l Clear Device Memony ]
24-03-2013 22:0216  DCY 0.44 mh 600
24.03.2013 220217 DCY 045 Y 600 [ Load Comparison Memory ] [ Clear Comparizon Memomy ]
24-03-2013 220218 DCY 044 m BO0
24-03-2013 220221 DCY 044 m 600
24-03-20135 22:02:25  DCY 0435 m 600
24-03-2013 22:02:24 DOV 044 m 600
24-03-2013 220225 DCY 043 m E00
24-03-2013 22:02:26  DCY 043 mh 600
24-03-2013 220227 DCY 043 m 600
24-03-2013 220228 DCY 043 m BO0
24-03-2013 220230 DCY 04z m 600
24-03-2013 22:02:31 DCy 0435 m 600
24-03-2013 220232 DOV 042 m 600
24-03-2013 220233 DCY 043 m E00
24-03-2013 22:02:34  DCY 043 mh 600
24-03-2013 220235 DCY 04z m 600
24-03-2013 220237 DOV 042 m BO0 - I I I
24-03-2013 220238 DCY 04z m 600 -
24-03-20135 22:02:38  DCY 0435 m 600 0 1 2 3 4 a BOOMY
24-03-2013 220241 DCv 042 m 600
24-03-2013 22:02:42  DCY 042 m E00 I
24-03-2013 22:02:43  DCY 04 mh 600
24-03-2013 220244 DCY 04z m 600
24-03-2013 220245 DCY o4 m BO0
24-03-2013 220246  DCY 04z m 600
24-03-20135 22:02:45  DCY o4 m 600
24-03-2013 220248 DCY o4 m 600
24-03-2013 220250 DCY 04 m E00

The VC890 Device Control Panel contains the following items in menu:

10
11
12
13

Device -> Data Record Settings
Device -> Device Settings
Device -> Display / Plot Data

Device -> Email Alert

Graph -> Plot Colour

Graph -> Background Colour
Graph -> Grid

Graph -> Line

Graph -> Points Indicator
Graph -> Print

Graph -> Save Image As

Graph -> Zoom Out
Graph -> Zoom To Fit

This will launch the setting page of VC890.
Launch extra setting page of VC890.

Select the time range that the device reading
should retrieve.

This will launch the email alert module.

(Available in Professional version only)

This will launch the Plot Colour module to change
the colour of the individual lines.

Change the background colour of the graph to
either black or white.

Control whether to show / hide the grid on the
graph area.

Control whether to show / hide the line on the
graph area.

Control whether to show / hide the points
indicator.

Prints the generated chart.

Save the image in the chosen file format.
Zoom out one level.

Undo all zoom in and out.
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6.21.4 VC890 — Settings

"\/YCB80 - Settings (HW ID:0009-000000000000507)

Basic Settings
Logger Mame

Sample Points

Sample Rate

Alarm Settings

heasurement

Device dizconnect.

Lo Level

[vCaED
40000

15

Skip repeat reading

Function

AC+DC

o

i [] Infinite

Lnit hade
v K v WY v

High Level (1000

I Setup H Cloze

1 Logger Name
2 Sample Points
3 Infinite

4 Sample Rate

5 Skip repeat reading

6 Alarm Settings™
7 Setup Button
8 Close Button

Input the unique alias for that device.

Configure the data logger sample points.

For real time mode only, the download will not stop
until the user stopped the download.

Instruct the data logger to log readings at a specific
rate.

System will not record a duplicate reading if this option
was checked.

Select the measurement column and alarm level.
Save changes.

Close this interface.

* Note: The alarm can be configured in the following measurement ranges:

Function Unit Mode
AC+DCV Vv N/A
AC+DCV Vv A
ACV Vv N/A
ACV Vv A
DCV Vv N/A
DCV Vv A
DCV mV N/A
DCV mV A
ACA MA N/A
ACA A N/A
ACA mA N/A
ACA HA A
ACA A A
ACA mA A
Continuity Q N/A
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Diode Vv N/A
Duty Cycle % N/A
DCA A N/A
DCA A N/A
DCA mA N/A
DCA LA A
DCA A A
DCA mA A
Capacity uF N/A
Capacity mF N/A
Capacity nF N/A
Capacity WF A
Capacity mF A
Capacity nF A
Freq Hz N/A
Freq kHz N/A
Freq MHz N/A
Impedance Q N/A
Impedance kQ N/A
Impedance MQ N/A
Temperature °C N/A
Temperature °F N/A
ACV Low-pass \Y; N/A
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6.21.5 VC890 — Device Setting

Extra settings are available for VC890, the user can launch them via Device -> Device Setting.

'\/ Device Setting

I1rme
1
05-01-201314:11:57 % | Lze System Time [ Set
Other Setting
Battery *) Alkaline () Li-Akku (Lithium battery) 2
Logoer Memory %) Fix ) Overwrite Z
Logger data display (=) Activate () Deactivate 4
Auta brightness =) Activate ) Deactivate 5
Logger sampling rate 1s » 6
Auta Power Off (%) A mins ) 18 mins 7
() 30 mins ) Mever
Set
Device connect.
1 Time Configure the device date time value.
The user can specify a defined time or use the system
date time.
2 Battery Configure the device current using Alkaline or Lithium
battery.
3 Logger Memory Configure logger memory to be fixed or overwritten
when full.
4 Logger data display Configure the battery saving mode to activate or not
during data logging.
5 Auto brightness Configure the battery saving mode to activate or not
during normal operation.
6 Logger sample rate Configure logger sample rate.
7 Auto Power Off Configure the auto power option
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6.21.6 VC890 - Download Data

This module allows user to download the storage data from VC890.

Download Data Q@@

The data will be downloaded from the device.
Hint: After downloading, the device will stop recording.

Device connect. [ 0K ] [ Cancel

Click “OK” button to stop the recording and start downloading.

6.21.7 VC890 — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display / Plot Data

Dizplay / Plat D ata
() PC storsge range Earliest data:  24-03-2013 21:26:18 Latest data: 24-03-2013 21:29:16

@ From 23-03-2013 21:31:45 v To: | 24-03-2013 22:31:45 v

il it
SHSHIRTEN Function Unit Mode

AC+DCY 4 W b N/& b

1 PC Storage Range Download all data stored in the database.

2 Time Range Select the data reading range.

3 Measurement User can select which measurement record to
download.

4 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

5 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.21.8 VCB890 — Data View

VC890 contains many different measurements, you will need to specify which measurement
(and unit) to download in “Display / Plot data” dialog.

Device  Graph

f'l Data \ Graph II‘.\
PC storage range Earliest data:  24-03-2013 22:02:05 Latest data:  Current Time
¥ Summary
Back to real time mode ] 4 [ Export Excel ] [ E xpart CSY ]
Recard Time Function Reading Unit Range SUE I Stop Record l [ Stop Displap ]
24-03-2013 22:02:05 DCY 045 my 600 Device Control 1
24-03-2013 22:02:06 DCY 0.45 my BO00
24.03-2013 220207 DCY 045 i 600 I tanual Fange ] [ Auto Range MAKAMIMAG Exit bax MG Besp Fass Beep
24-03-2013 22:02:09 DCY 045 my 600
24032013 220210 DO 045 oy 500 [ selst  J[ Had | REL ][ Light [ COMPVaue || COMPSetting |
24-03-2013 22:02:11 DCY 045 my 600 - -
24032013 220212 DOV 0.45 my 600 [ Single Log ] [ Seies Log ]
24-03-2013 220213 DCY 0.45 my BO00 - -
24.03-2013 220215 DOY 045 Y 500 [ Load Device Memomny ] [ Clear Device Memory ] 2
24-03-2013 22:02:16 DCY 0.44 my 600
24.03.2013 2202417 DCY 0.45 my 500 [ Load Comparison Memaory H Clear Comparizon Memary ]
24.03-2013 22:02:19 DCY 044 my 600
24-03-2013 2202221 DCY 0.44 my 600
24-03-2013 22:02:23 DCY 0.43 my BO00
24-03-2013 2202:24  DCY 0.44 my 600
24.03-2013 22:02:25 DCY 0.43 my 600
24-03-2013 22:02:26 DCY 0.43 my BO00
24-03-2013 2202:27  DCY 043 my 600 3
24.03-2013 22:02:29 DCY 0.43 my 600
24-03-2013 22:02:30 DCY 042 my BO00
24-03-2013 22023 DCY 043 my 600
24.03-2013 22:02:32 DCY 0.42 my 600
24.03-2013 220233 DCY 0.43 v 500 Bl
24-03-2013 2202:3¢  DCY 043 my 600
24.03-2013 22:02:35 DCY 0.42 my 600 OOO 20
24-03-2013 22:02:37 DCY 042 my BO00 " I I IV
24-03-2013 2202:38 DCY 042 my 600
24.03-2013 22:02:39 DCY 0.43 my 600 - 0 '] 2 3 4 5 BOOmV
24-03-2013 2202241 DCY 042 my BO00
24-03-2013 2202:42 DCY 042 my 600 I
24.03-2013 22:02:43 DCY o4 my 600
24-03-2013 22:02:44 DCY 042 my BO00
24-03-2013 2202:45 DCY 04 my 600
24.03-2013 22:02:46 DCY 0.42 my 600
1 Record / Display Use these two buttons to toggle between display and record
Button mode.
In display mode, the reading measured by the device will
be displayed in the display area.
In record mode, the reading measured will not only display
in the display area, but also be stored in the database for
future use.
N.B.
i) If the device is in record mode this means it is also in
display mode.
ii) Stopping the display mode will also stop the record
mode.
2 Command Button Refer to below section.
3 Display Area Display the measured value.
4 Back to real time This button will be displayed when the device is in real time
mode mode but the interface is not showing real-time data (e.g.

downloading log data / historical data).

Clicking this button can return the interface to displaying
real-time data.

Command Button

Manual Range Click to send commands to make device entering the
manual range.
Auto Range Click to send commands to make device entering the
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MAX / MIN / AVG
Exit Max

NG Beep
Light

Select

Hold

REL

Pass Beep
COMP Value
COMP Setting
Single Log

Series Log

Load Comparison Memory

Clear Comparison Memory
Load Device Memory

Clear Device Memory

Data Comparison dialog

auto range.

Click to send commands to enable maximum, minimum,
average function.

Click to send commands to exit maximum, minimum,
average function.

In the COMP VALUE mode, if failed, click button to turn
the alarm on/off.

Click to send commands to enable device backlight
function, and then click the exit functions.

Click to send commands to enable device function
selection.

Click to send commands to enable device to maintain the
function, and then click to exit maintain function.

Click to send commands to enable the relative value
function; then click to exit the function.

In the COMP VALUE mode, if passed, click button to turn
the alarm on/off.

Enter / Leave COMP value mode.

Pop up Data Comparison dialog.

Click to send commands to enable device to store a
single data.

Click to send commands to enable device to continuously
store data, and then click to exit the function.

Click to send commands to send out the comparison data
stored by device.

Clear the comparison data in device.

Click to send commands to send out the no comparison
data stored by device.

Clear the no comparison data in device.

Higgh Lirnit 100

Lo Lirmit 0

Inner f Outer Outer v Setup Enter

4

4

Setup Enter : When button is pressed, the settings will be sent and saved in the device.
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6.21.9 VC890 — Graph View
Data Graph \
VC890 - 890
0.50 | : :
0.45 ﬁ
0.40 ——
> 035 1
E g
8 030 T
0.25 ——
0.20 ——
0.15 + | ; ; , , |
22:01:00 22:06:00 22:11:00
24-03-2013 24-03-2013 24-03-2013
Time

Our graph supports the following operations

1

2
3
4

Mouse wheel

Mouse click and drag
Shift + mouse click
Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values
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6.21.10 VC890 — Web Interface

Please refer to section 5.6 on how to launch the web interface.
The web interface for VC890 is similar to Windows version, except two points:
1. Downloaded data can only have 10,000 readings in a single download.

2. The status of the “Record” and “Display” button will not be refreshed automatically. A
“Refresh” button was therefore added, so click on the button to refresh the button

status.
VC890- 880 (1|
Device Graph
Data Graph
PC storage range Earfiest data: 24-03-2013 22:02:05 Latest data: 24-03-2013 22:14:12
¥ Summary
Export CSV Export Excel
Record Time Function Reading Unit Range Sub Ve | | SuiRecon || StanDisplay
Command Key
| Msnus| Rangs H Auto Range H MAXMINAVG H Exit Msx H NG Besp H Pas= Besp ‘
| Salect H Hold H REL H Light H COMP Vslus H COMP Satting ‘
Single Log Series Log

Losd Device Mamary Clesr Device Mamary

Losd Comparison Memory || Clear Comparison Memory

)

Lo
Auto
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6.22 EL4000

EL4000 is a data logger which measures the power consumption of different electronic devices.

6.22.1 Add new EL4000

As EL4000 will not be physically connected to computer, therefore, to create a new EL4000 in
Voltsoft, user is required to select Device Management-=Add New Device in menu.

\/ Add New Device Ai=l.3

Device Series | EL4000

Model Nurnber | EL4000

Alias EL4000)

Auto-Detect [ Add l [

Select “EL4000” in device series, “EL4000” in model number, enter a unique device alias and
click the “Add” button.

6.22.2 Remove EL4000

To remove EL4000, go to Device Management -> Remove Existing Device and its PC data
Storage, select the device you want to remove and click the “Remove” button.

180



Voltsoft User Manual Version 2.5

6.22.3 EL4000 — Device Control Panel

Device  Graph

f Data \

PC storage range Earliest data:  05-03-2012 10:37:00 Latest data: 10-10-2012 20:40:00
% Summary
All Data Expart Excel ] [ Export C5Y
Recard Tine Current (&) Active Power (A Apparent Power 000 -
05-09-2012 10:37:00 2253 0 0
05-09-2012 10:35:00 2258 0 0
05-09-2012 10:38:00 2255 0 0
05-09-2012 10:40:00 57 541 0 0
05-09-2012 10:41:00 3082 355 5169 711 6334
05-09-2012 10:42:00 0 0 0
05-09-2012 10:43:00 0 0 0
05-09-2012 10:44:00 0 0 0
05-09-2012 10:45:00 0 0 0
05-09-2012 10:46:00 0 0 0
05-09-2012 10:47:00 0 0 0
05-09-2012 10:45:00 0 0 0
05-09-2012 10:49:00 0 0 0
05-09-2012 10:50:00 0.009 0.303335 2.0258
05-09-2012 10:51:00 0 0 0
05-09-2012 10:52:00 0.01 0.3375 225
05-09-2012 10:53:00 0.008 0.234104 1.6008
05-09-2012 10:54:00 0.004 0.063 0.9
05-09-2012 10:55:00 0.005 0121605 1.3512
05-09-2012 10:56:00 0.005 0121662 1.3518
05-09-2012 10:57:00 0 0 0
05-09-2012 10:55:00 0 0 0
05-09-2012 10:58:00 0 0 0
05-09-2012 11:00:00 0 0 0
05-09-2012 11:01:00 0 0 0
05-09-2012 11:02:00 0 0 0
05-09-2012 11:03:00 0 0 0 w
The EL4000 Device Control Panel contains the following items in menu:
1 Device -> Settings This will launch the setting page of EL4000.
2 Device -> Download Data Download reading from device.
3 Device -> Display / Plot Data Select the time range that the device reading
should retrieve.
4 Graph -> Plot Colour This will launch the Plot Colour module to change
the colour of the individual lines.
5 Graph -> Background Colour Change the background colour of the graph to
either black or white.
6 Graph -> Grid Control whether to show / hide the grid on the
graph area.
7 Graph -> Line Control whether to show / hide the line on the
graph area.
8 Graph -> Points Indicator Control whether to show / hide the points
indicator.
9 Graph -> Print Prints the generated chart.
10 Graph -> Save Image As Save the image in the chosen file format.
11 Graph -> Zoom Out Zoom out one level.
12 Graph -> Zoom To Fit Undo all zoom in and out.
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6.22.4 EL4000 — Settings

\/ Setting

Basic Settings

Time ' | [4] Use System Time

Date Format: @ ddimmiyyyy O mmiddiyyyy

Time Format: (&) 24-hour O 12-hour

Logger MName 4000

Logger ID 0 v |

Currency Pound v

Tariff1 0.00

Tarifi2 0.00 |

[ Default ] [ Save ] I Setup ] [ Close ]
1 Time Configure the device data time value.
The user can specify a defined time or use the system
date time.

2 Date Format Select either dd/mm/yyyy or mm/dd/yyyy
3 Time Format Select either 24 / 12 hour format.
4 Logger Name Input the unique alias for that device.
5 Logger ID Select logger ID, from 0 — 9.
6 Currency Select the currency, for calculation.
7 Tariff 1 Price for Period 1
8 Tariff 2 Price for Period 2
9 Default Restore the default value
10 Save Button Save setting changes
11 Setup Button Save changes and export the configuration file.
12 Close Button Close this interface.
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6.22.5 EL4000 - Download Data

This module allows user to download the storage data from EL4000.

Download Data

Browsze the location of data files:

[ oK H Cancel l

To download data, click “...”, select the location of data files, and then click the “Download”
button to start downloading.

Please note that the logger ID of the data file must be the same of the logger ID configured in
setting, otherwise download will not be allowed.

6.22.6 EL4000 — Display / Plot Data

This module allows user to select a range for the device readings from the device and display
them in the data tab and graph tab.

Display/Plot Data

Dizplay/Flot D ata
) PC storage range Earliest data: M4 Latest data; MA&

=) Fram: 03-12-2012 16:22:34 b To: (10122012 17.22.34 b

Device connect.

[ ok || Cose |
1 PC Storage Range Download all data stored in the database.
2 Time Range Select the data reading range.
3 OK Click OK to accept the input and display the selected
reading in the data and graph tabs.

4 Cancel Close this module.

The loading time will increase when more data is retrieved; therefore, the system will be
limited to return the first 100,000 records which meet your selection criteria. (For the Web
version, only the first 10,000 records will be returned.)
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6.22.7 EL4000 — Data View

EL4000 contains three measurements (Current, Active Power and Apparent Power),

Device  Graph

f Data \ I

PC storage range Earliest data:  05-03-2012 10:37:00 Latest data:  10-10-2012 20:40:00

¥ Surarnary

All Data Expart Excel ] [ Export CSY

Recard Time Current (&) Active Power (A Apparent Power 0 G

05-09-201210:37:00 2255 o ]

05-09-201 2 10::38:00 2258 0 0

05-09-2012 10:39:00 2255 ] ]

05-09-2012 10:40:00 a7 .5d 1] u]

05-09-201210:41:00 3.052 3558169 7116335

05-09-2012 10:42:00 0 0 0

05-09-2012 10:43:00 0 0 0

05-09-2012 10:44:00 1] 1] u]

05-09-2012 10:45:00 1] 1] u]

05-09-2012 10:46:00 o o ]

0:5-09-201 2 10:47.00 0 0 0

05-09-2012 10:45:00 ] ] ]

05-09-2012 10:49:00 1] 1] u]

05-09-2012 10:50:00 0.o09 03035385 2.0259

0:5-09-201 2 10:51:00 0 0 0

05-09-2012 10:52:00 0.01 03375 225

05-09-201210:53:00 0.005 0234104 1.5005

05-09-2012 10:54:00 0.004 0063 08

05-09-201 2 10:55:00 0.006 0121603 1.3512

05-09-2012 10:56:00 0.005 0121662 1.3318

05-09-201210:57:00 1] 1] u]

05-09-2012 10:55:00 o o ]

05-09-201 2 10:59:00 0 0 0

05-09-2012 11:00:00 ] ] ]

05-09-2012 11:01:00 1] 1] u]

05-09-2012 11:02:00 1] 1] u]

05-09-2012 11:03:00 0 0 0 W
1 Export Excel Export the reading to Excel (.xls) format.
2 Export CSV Export the reading to Excel (.csv) format.
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6.22.8 EL4000 — Graph View
. Device  Graph
IF'I Data }( Graph \
EL4000 - EL4000 Calculate
[ = Current 4 Artive Power > Apparent Power |
| 800 T—————— . ————— 7 710
o0 T &0
| go0 [
[ <+ 50
so0 |
3 _ 440 F
5 400 1 -
2 -
S T a3
300 + L
[ Lo
200 T r
100 70
o 4+ L 0
00:00:00 00:00:00 00:00:00 00:00:00 00:00:00 00:00:00 00:00:00
01-09-2012 08-09-2012 15-09-2012 22-09-2012 29-09-2012 06-10-2012 13-10-2012

Our graph supports the following operations

1 Mouse wheel

2 Mouse click and drag
3 Shift + mouse click
4 Mouse over on point

Zoom-in / Zoom-Out
Zoom-in

Pan

Display reading values
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6.22.9 EL4000 — Calculate

User can calculate the price for power consumption by using this module.

\/ Calculation

Price Settingz Reszults
From 1 Conzumption: | 13.42 kKiw'h
05-03-2012 10:37 hd Cost £1.96
To
10-10-2012 20:40 v Forcast
Monthly
Frice 1 Conzumption: | 11.369 kKwh
: . = 2
FTEIITI. DEDD - EDSt: E -IEE
To: 13:59 5 Yearly
PTICE[E ] 0,100 Aadk EDHSumptiDﬂZ 138.323 IMwh
Price 2 Coszt: £ 2017
From:
To
Price:[# ] |0.200 Aah
Calculate
1 From / To Define the record period

2 Price 1 / Price 2

Click the “Calculate” button to calculate the price.

6.22.10 EL4000 —Web Interface

Please refer to section 5.6 on how to launch the web interface.

Unit price for different time period

The web interface for EL4000 is the same as Windows version, except the downloaded data
can only have 10,000 readings in a single download.

186



Voltsoft User Manual Version 2.5

7 Auto Upgrade

Voltsoft will perform version checking every time when it starts up, and if there is a new
version available, the following dialog box will be displayed:

Yoltsoft System Upgrade |[%

Mew Yersion Found!
Do ol wish ko updake at this time?

fes | [ Mo

User can click “Yes” to perform an upgrade or “No” to skip the upgrade. In order to enjoy the
new features of Voltsoft, it is highly recommended to perform the upgrade.

System Updater,

Downloading latest application...

[ LLLLLI

The system will continue to launch once the upgrade is completed.
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8 Appendix
8.1 Real-Time device list

Only the following devices will have real-time features:

Family Model Number
Data Logger DL131G
DL161S
SL400
DMM VC 930 / VC950
DMM VC 880 / VC650BT / VC890

Remarks: The speed of data logging (i.e. sample rate) much depends on the capacity of your
computer and its performance will be affected when 2 or more sets of real-time devices are
running at the same time.

8.2 Internet Explorer 10

Current version of Voltsoft web version do not support Internet Explorer 10 (1.E. 10), to access
Voltsoft by I.E. 10, please select “Tools”->"F12 developer tools” in user menu, then select
“Internet Explorer 9” for Browser Mode.

File Edit View Favourites Help
Delete browsing history... Ctrl+Shift+Del
InPrivate Browsing Ctrl+5Shift+P

Tracking Protection...
ActiveX Filtering

Fix connection problems...
Reopen last browsing session

Add site to Start Screen

View downloads Ctrl+)
Pop-up Blocker 2
Smart5creen Filter »
Manage add-ons

Compatibility View

Compatibility View settings

Subscribe to this feed...

Feed discovery »
Windows Update

F12 developer tools

Internet options
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File Find Disable View Images Cache Tools Validate | [l ]

C55  Console Script  Profiler Metwork

hRE* EHE

I
I

Document Mode: |ET standards

Internet Explorer 10
Internet Explorer10 Compatibility View

yo<!-- DOCTYPE htmli PUBLIC "-//W3C//DTD XHTML 1
E-<html xmlns="http://www.w3.org/1999/xhtml">

E Internet Explorer 9
Internet Explorer 8
Internet Explorer 7

Search HTML...

yout  Attributes

189




	1  Introduction
	2  Using this Manual
	3  Installation
	3.1 System Requirements
	3.2  Install Voltsoft
	3.3 Migrate existing data
	3.4  Register Voltsoft

	4  Standard Version
	4.1 Launch the Voltsoft Windows Client
	4.2  General Settings
	4.3  Add New Device
	4.4  Remove Existing Device
	4.5  Device Control Panel

	5  Professional Version
	5.1 User Management
	5.2 Email Management
	5.3  Email Template
	5.4 Email Alert
	5.5  Custom Graph
	5.6  Web Interface
	5.6.1 Using the Voltsoft System (Web)
	5.6.2  Accessing Voltsoft Web from a Remote Computer
	5.6.3  Using the Voltsoft System (Web)
	5.6.4 Limitation in Web Version


	6  Supported Devices
	6.1  DL101T
	6.1.1 Add new DL101T
	6.1.2 Remove DL101T
	6.1.3 DL101T – Device Control Panel
	6.1.4 DL101T - Settings
	6.1.5  DL101T - Download Data
	6.1.6 DL101T – Display / Plot Data
	6.1.7  DL101T – Data View
	6.1.8  DL101T – Graph View
	6.1.9 DL101T – Web Interface

	6.2  DL121TH
	6.2.1 Add new DL121TH
	6.2.2 Remove DL121TH
	6.2.3  DL121TH – Device Control Panel
	6.2.4  DL121TH - Settings
	6.2.5  DL121TH - Download Data
	6.2.6 DL121TH – Display / Plot Data
	6.2.7  DL121TH – Data View
	6.2.8  DL121TH – Graph View
	6.2.9 DL121TH –Web Interface

	6.3  DL131G
	6.3.1 Add new DL131G
	6.3.2 Remove DL131G
	6.3.3  DL131G – Device Control Panel
	6.3.4 DL131G – Settings
	6.3.5  DL131G - Download Data
	6.3.6 DL131G – Display / Plot Data
	6.3.7  DL131G – Data View
	6.3.8  DL131G – Graph View
	6.3.9  DL131G – Real Time FFT

	6.4  DL141TH
	6.4.1 Add new DL141TH
	6.4.2 Remove DL141TH
	6.4.3  DL141TH – Device Control Panel
	6.4.4  DL141TH – Settings
	6.4.5 DL141TH - Download Data
	6.4.6 DL141TH – Display / Plot Data
	6.4.7  DL141TH – Data View
	6.4.8 DL141TH – Graph View
	6.4.9 DL141TH – Web Interface

	6.5  DL161S
	6.5.1 Add new DL161S
	6.5.2 Remove DL161S
	6.5.3  DL161S – Device Control Panel
	6.5.4 DL161S – Settings
	6.5.5 DL161S - Download Data
	6.5.6 DL161S – Display / Plot Data
	6.5.7 DL161S – Data View
	6.5.8  DL161S – Graph View
	6.5.9  DL161S – Email Alert
	6.5.10 DL161S – Calibration
	6.5.11  DL161S – Web Interface

	6.6  DL141TH2K
	6.6.1 Add new DL141TH2K
	6.6.2 Remove DL141TH2K
	6.6.3 DL141TH2K– Device Control Panel
	6.6.4 DT141TH2K - Settings
	6.6.5  DL141TH2K - Download Data
	6.6.6 DL141TH2K– Display / Plot Data
	6.6.7  DL141TH2K – Data View
	6.6.8  DL141TH2K– Graph View
	6.6.9 DL141TH2K– Web Interface

	6.7  DL181THP
	6.7.1 Add new DL181THP
	6.7.2 Remove DL181THP
	6.7.3  DL181THP – Device Control Panel
	6.7.4  DL181THP – Settings
	6.7.5 DL181THP - Download Data
	6.7.6 DL181THP – Display / Plot Data
	6.7.7  DL181THP – Data View
	6.7.8 DL181THP – Graph View
	6.7.9  DL181THP – Web Interface

	6.8  DL131LUX
	6.8.1 Add new DL131LUX
	6.8.2 Remove DL131LUX
	6.8.3 DL131LUX – Device Control Panel
	6.8.4 DL131LUX - Settings
	6.8.5  DL131LUX - Download Data
	6.8.6 DL131LUX – Display / Plot Data
	6.8.7  DL131LUX – Data View
	6.8.8  DL131LUX – Graph View
	6.8.9 DL131LUX – Web Interface

	6.9  DL161SAN
	6.9.1 Add new DL161SAN
	6.9.2 Remove DL161SAN
	6.9.3 DL161SAN – Device Control Panel
	6.9.4 DL161SAN - Settings
	6.9.5  DL161SAN - Download Data
	6.9.6 DL161SAN – Display / Plot Data
	6.9.7  DL161SAN – Data View
	6.9.8  DL161SAN – Graph View
	6.9.9 DL161SAN – Web Interface

	6.10  DL201THM
	6.10.1 Add new DL201THM
	6.10.2 Remove DL201THM
	6.10.3 DL201THM – Device Control Panel
	6.10.4 DL201THM - Settings
	6.10.5  DL201THM - Download Data
	6.10.6 DL201THM – Display / Plot Data
	6.10.7  DL201THM – Data View
	6.10.8  DL201THM – Graph View
	6.10.9 DL201THM – Web Interface

	6.11  DL111K
	6.11.1 Add new DL111K
	6.11.2 Remove DL111K
	6.11.3  DL111K – Device Control Panel
	6.11.4  DL111K – Settings
	6.11.5  DL111K - Download Data
	6.11.6 DL111K – Display / Plot Data
	6.11.7  DL111K – Data View
	6.11.8  DL111K – Graph View
	6.11.9 DL111K – Web Interface

	6.12  DL191A
	6.12.1 Add new DL191A
	6.12.2 Remove DL191A
	6.12.3  DL191A – Device Control Panel
	6.12.4  DL191A – Settings
	6.12.5  DL191A - Download Data
	6.12.6 DL191A – Display / Plot Data
	6.12.7  DL191A – Data View
	6.12.8 DL191A – Graph View
	6.12.9 DL191A – Web Interface

	6.13  DL191V
	6.13.1 Add new DL191V
	6.13.2 Remove DL191V
	6.13.3  DL191V – Device Control Panel
	6.13.4  DL191V – Settings
	6.13.5  DL191V - Download Data
	6.13.6 DL191V – Display / Plot Data
	6.13.7  DL191V – Data View
	6.13.8 DL191V – Graph View
	6.13.9 DL191V – Web Interface

	6.14  DL151AN
	6.14.1 Add new DL151AN
	6.14.2 Remove DL151AN
	6.14.3  DL151AN – Device Control Panel
	6.14.4  DL151AN – Settings
	6.14.5  DL151AN - Download Data
	6.14.6 DL151AN – Display / Plot Data
	6.14.7  DL151AN – Data View
	6.14.8 DL151AN – Graph View
	6.14.9 DL151AN – Web Interface

	6.15  DL200T / DL210TH / DL220THP
	6.15.1 Add new DL200T / DL210TH / DL220THP
	6.15.2 Remove DL200T / DL210TH / DL220THP
	6.15.3  DL200T / DL210TH / DL220THP – Device Control Panel
	6.15.4 DL200T / DL210TH / DL220THP - Settings
	6.15.5  DL200T / DL210TH / DL220THP - Download Data
	6.15.6 DL200T / DL210TH / DL220THP – Display / Plot Data
	6.15.7  DL200T / DL210TH / DL220THP – Data View
	6.15.8  DL200T / DL210TH / DL220THP – Graph View
	6.15.9 DL200T / DL210TH / DL220THP – Web Interface

	6.16  PL-125-T2 / PL-125-T4
	6.16.1 Add new PL-125-T2 / PL-125-T4
	6.16.2 Remove PL-125-T2 / PL-125-T4
	6.16.3  PL-125-T2 / PL-125-T4 – Device Control Panel
	6.16.4  PL125-T2 / PL-125-T4 - Settings
	6.16.5  PL125-T2 / PL-125-T4 - Download Data
	6.16.6 PL125-T2 / PL-125-T4 – Display / Plot Data
	6.16.7  PL125-T2 / PL-125-T4 – Data View
	6.16.8  PL125-T2 / PL-125-T4 – Graph View
	6.16.9 PL125-T2 / PL-125-T4 –Web Interface

	6.17  IR 1200-50D / IR 1201-50D
	6.17.1 Add new IR 1200-50D / IR-1201-50D
	6.17.2 Remove IR 1200-50D / IR-1201-50D
	6.17.3  IR 1200-50D / IR-1201-50D – Device Control Panel
	6.17.4  IR 1200-50D / IR-1201-50D – Settings
	6.17.5  IR 1200-50D / IR-1201-50D – Play (Real Time Mode)
	6.17.6 IR 1200-50D / IR-1201-50D – Download Store Data
	6.17.7  IR 1200-50D / IR-1201-50D – Display / Plot Data
	6.17.8  IR 1200-50D / IR-1201-50D – Data View
	6.17.9  IR 1200-50D / IR-1201-50D – Graph View
	6.17.10 IR 1200-50D / IR-1201-50D – Web Interface

	6.18  SL451
	6.18.1 Add new SL451
	6.18.2 Remove SL451
	6.18.3  SL451 – Device Control Panel
	6.18.4 SL451 – Settings
	6.18.5 SL451 - Download Data
	6.18.6  SL451 – Display / Plot Data
	6.18.7  SL451 – Data View
	6.18.8 SL451 – Graph View
	6.18.9 SL451 – Email Alert
	6.18.10 SL451 – Web Interface

	6.19  VC930 / VC950
	6.19.1 Add new VC930 / VC950
	6.19.2 Remove VC930 / VC950
	6.19.3  VC930 / VC950 – Device Control Panel
	6.19.4  VC930 / VC950 - Download Data
	6.19.5 VC930 / VC950 – Settings
	6.19.6  VC930 / VC950 – Display / Plot Data
	6.19.7  VC930 / VC950 – Data View
	6.19.8 VC930 / VC950 – Graph View
	6.19.9  VC930 / VC950 – Web Interface

	6.20  VC880 / VC650BT
	6.20.1 Add new VC880 / VC650BT
	6.20.2 Remove VC880 / VC650BT
	6.20.3  VC880 / VC650BT – Device Control Panel
	6.20.4  VC880 / VC650BT – Settings
	6.20.5  VC880 / VC650BT – Display / Plot Data
	6.20.6  VC880 / VC650BT – Data View
	6.20.7 VC880 / VC650BT – Graph View
	6.20.8  VC880 / VC650BT – Web Interface

	6.21  VC890
	6.21.1 Add new VC890
	6.21.2 Remove VC890
	6.21.3  VC890 – Device Control Panel
	6.21.4  VC890 – Settings
	6.21.5  VC890 – Device Setting
	6.21.6  VC890 - Download Data
	6.21.7 VC890 – Display / Plot Data
	6.21.8  VC890 – Data View
	6.21.9 VC890 – Graph View
	6.21.10  VC890 – Web Interface

	6.22  EL4000
	6.22.1 Add new EL4000
	6.22.2 Remove EL4000
	6.22.3  EL4000 – Device Control Panel
	6.22.4 EL4000 – Settings
	6.22.5  EL4000 - Download Data
	6.22.6 EL4000 – Display / Plot Data
	6.22.7  EL4000 – Data View
	6.22.8  EL4000 – Graph View
	6.22.9  EL4000 – Calculate
	6.22.10 EL4000 –Web Interface


	7  Auto Upgrade
	8  Appendix
	8.1 Real-Time device list
	8.2 Internet Explorer 10


